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Main Meeting, January 8 
Anthony Simonetti of New Horizons Computer Learning Centers will give  

a presentation on the Google Chrome web browser. (See page 3) 
Big prizes for our January raffles  

(such as a Blu-Ray DVD Burner & an Epson All-in-One Printer)  (See page 4)  
December raffle winners’ pix (Page 17) 

We will not have a Consignment Table or E-Waste Collection during the Jan. 2012 meeting. (See page 5) 

Special Interest Group (SIG) & Main Meeting 

9:00 a.m. 
Linux for Desktop Users………....................Science 131 
Topics about the Linux operating system.  Beginner’s Qs here. 
 

Visual Programming..……………………..….Science 111 
Visual Basic, Visual BasicScript, Visual C++ and Visual J++. 
 

Come, Care, and Share................................Science 109 
Any computer-related topics you want to discuss. 
 

Beginners Digital Photography……..........Science 131A 
Topics about digital photography.     
Microsoft Word, Excel, and Outlook…….…Science 306 
Three parts of the Microsoft Office Suite plus Open Office.  

Reviews & Consignment Tables, Coffee & Donuts: Irvine Hall Lobby 

10:30 a.m. 
Beginners PC Q & A ......................................  Irvine Hall 
Building your own PC and other topics! 
 

Linux Administration………………...............Science 131 
More topics about the Linux operating system. 
 
Access/Excel VBA……………………….……Science 306 
Access & Excel VBA code. 

10:30 a.m. 
Advanced Digital Photography………………..Science 131A 
Making sense of modern auto focus cameras.   
 
Understanding Operating Systems…………....Science 111 
Help with DOS, Windows, OS/2, etc. 
 
Mobile Computing.... ……..................................Science 109 
This SIG discusses mobile devices.  

12:00 Noon 
PIG SIG………………………….………..Hashinger Courtyard 
 
Microsoft Access ………….....................…….…Science 306 
Database applications and more. 

12:30 p.m. 
Advanced PC Q & A…………………….......…….…Irvine Hall 
PC hardware & software topics. 
 
2:00 p.m. Main Meeting…….…..Irvine Hall 

NOCCC website: 
http://www.noccc.org 

Future Meeting Dates in 2012: 
  

Feb. 5, Mar. 4, Apr. 1, May 6 

*SWUG 1st Prize in 2004, 2005, 2006 APCUG 2nd Prize in 2003, 2004, 2005 Founded April 1976 
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Publication Chairman - Oversees publication tasks and converts the 
Orange Bytes newsletter to PDF for printing and web posting; transmits 
PDF to Printer. 
Ted Littman.................................(714) 779-1936, tedlit@roadrunner.com 
 
Editor - Edits and makes final selections of the articles to be included in the 
newsletter. 
Ted Littman...................................................................  editor@noccc.org  
 
Associate Editor/Production - Receives articles from the editor and lays 
out the issue of the newsletter. 
Ted Littman, acting ............................................... tedlit@roadrunner.com 
 
Circulation - Oversees mailing and distribution of the newsletter. 
Richard Miller .................................... (714) 309-1504, rrrmil@gmail.com 
 
Reviews Editor - Communicates with the vendors and members who 
evaluate products and write reviews.  Makes sure members meet deadlines.  
Sends a copy of the newsletter to vendors of products we review. 
Ted Littman...................................... (714) 779-1936, reviews@noccc.org 
 
Copy Editor - Does final proof reading of the newsletter for typos and 
misspellings. 
Dennis Martin…………….(951) 926-3065, dennismartin@dslextreme.com 
 
 
VOLUNTEERS NEEDED 
 
The following positions are available: 
Social Media Contacts – Maintain and write articles for the newsletter. 
 
Contributing Editors - Write articles for the newsletter. 
 
Commercial Advertising - Obtains ads from vendors for the newsletter. 
 
Classified Advertising - Obtains computer-related, non-commercial ads for 

the newsletter free to NOCCC members. 

Contact editor@noccc.org or (714) 779-1936. 

              Celebrating 35 years of 
“Friends Helping 

Friends” 
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Jan. 8th  Main Meeting 
 2 p.m. Irvine Hall 

Our speaker, Anthony Simonetti, is an Acount 
Executive at New Horizons Computer Learning 
Centers of California. His profile is on LinkedIn: 
http://www.linkedin.com/pub/anthony-simonetti/9/ba9/7ba. He 
will tell us how to best use Google’s fast, second- 
most-widely-used browser, Google Chrome. A free 
download of Chrome is at: 
https://www.google.com/chrome?hl=en&brand=CHFX&utm_campaig
n=en&utm_source=en-oa-na-us-bk-bng&utm_medium=oatment.  

President’s Message 
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By Jim Sanders, NOCCC  

n a conversation with one of the club members during 
December's meeting, I was asked if I could set up a SIG that 
dealt with the new Apple products. The iPhone, iTouch, and 
the iPad in particular. The answer, of necessity, is no! Not 

that I wouldn't like to do that. I am sure that if we had a SIG that 
dealt with those products it would be quite popular. As good as 
the Android products are, and they are rapidly getting better, 
there is still no question that at the moment Apple has sold the 
lot more of their products. By one estimate, Apple owns 65% of 
the tablet market and rumor has it that the iPad3 may be 
released in February or March of 2012. One market analyst 
estimated that Apple would sell about 12 million to 13 million 
iPads in the final three months of this year. Now that is 
worldwide sales, but even if that means there would only be a 
few thousand iPads sold in Orange County, surely 15 to 20 of 
those people would be interested in a SIG that dealt with their 
favorite toy. But, like all of the SIG's, someone has to be willing 
to volunteer their time to be the leader of that SIG. Again, they 
don't have to be an expert on the topic, though I grant you that 
helps a lot, but they do at least have to be able and willing to 
LEAD a SIG. So if some one of you members who owns an 
iPad thinks that having a SIG for that product would a great 
idea, and is willing to do something to make it happen, I would 
be more than happy to provide a time slot and a room 

Last month saw AT&T’s release of the new Samsung Galaxy II 
S phone that is based on the Android 4.0 operating system. As 

near as I can tell, if you're not in the Apple camp, the Galaxy II 
S is THE hot item in the cell phone market. Indeed, it seems to 
be getting a fair amount of press as a handheld computer that 
also happens to be a phone, a decent camera, and a GPS. 
Featuring a 1.2 GHz dual core CPU with up to 32 GB of internal 
memory and up to 32 GB of removable memory via a micro-SD 
card, it is in fact a pretty potent little handheld computer. 
 

It was a pleasure to see John Johnson show up at the club 
meeting after far too long of an absence. Larry Klees did a great 
job of explaining Flickr.com during his Main meeting 
presentation in December. In fact his enthusiasm for explaining 
the different features of the program was so great that it was 
almost difficult to get him to stop. He kept answering “just one 
more question.” A reminder once again, the club needs a 
volunteer to fill the office of VP. We have gone many months 
without anyone in that office and it needs to have an occupant. 
As President, I can appoint someone to that office, but it does 
require a volunteer who is willing to spend a few hours a month 
of his/her time to fulfill the requirements of the office which are 
not that great. Would somebody please step up to the plate? 
 

Preparing a Review or Article for 
the NOCCC Orange Bytes 

By Steven Breitbart, NOCCC 

here are two sections in the NOCCC newsletter, the 
Orange Bytes, where our members can contribute 
reviews and articles.  They are the Computer Talk 

section and the Product Reviews section. 
Articles in the Computer Talk section can be about almost any 
computer or technology related experience that you have had.  
For example, getting a new ISP, getting an ISP to change your 
connection speed, converting a PC to Linux, using a MacIntosh 
PC for the first time - the list is endless. 
 

The Product Reviews section can be a review of almost any 
type of computer hardware, software, or book about a computer- 
related topic.  The item can be something you have bought or 
obtained from the NOCCC.  Once you agree to do a review, you 
will generally have 2 months to complete it.  These reviews are 
published in this newsletter, the Orange Bytes. 
The NOCCC Reviews Editor, Ted Littman, (714) 779-1936, 
reviews@noccc.org is regularly sent copies of books and 
software by the publishers for review by our members.  We 
need NOCCC members to take these items and commit to 
reviewing them promptly.  The reward for doing a review is 
that you get to keep the book or software.  If we do not 
review them, they may stop sending these items in the future. 
Important!  There are two articles at the following link.  One 
provides suggestions and guidelines for preparing a review or 
article for the Orange Bytes.  The second provides guidelines for 
submittal. The link is: www.noccc.org/bytes/info/index.html. 
The NOCCC reserves the right to refuse to publish any article or 
review at the discretion of the editors of the Orange Bytes 
newsletter or officers of the club.  Reasons may include, but are 
not limited to, length and quality of the review or offensive 
nature of the product or of the review. 

I 

T
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s a valued member, we bring you a section of discounts 
and offers as part of the entire “Benefit of Belonging.”  
(Caveat: we are unable to endorse these companies, but 

make these offers available as a service to our members.) 
A 

Membership Benefits 
Free Internet Libraries - Upon retiring from college 
teaching/administration, Walter Antoniotti  began developing  
 
Free Internet Libraries for students, teachers, and professionals.  
(http://www.businessbookmall.com/Free Internet Libraries.htm) 
Of special interest to PC users are these free computer libraries: 

 
User Group Offers - Software and Hardware 
 Free Business Software 

(http://www.businessbookmall.com/Free Business 
Software Internet Library.htm) 

User Group Relations – You can now order the latest release 
of Acronis True Image 2012 from Gene Barlow for only $25 
(download) or $25 plus S&H (on a CD).  This top-rated backup 
utility has many new features and will work with Windows 7. 
Use the following link for special pricing for user group 
members: www.ugr.com/TrueImage.html. 

Free Software Tutorials 
(http://www.businessbookmall.com/Software Tutorials 
Internet Library.htm) 
Excel Internet Library 
(http://www.businessbookmall.com/Microsoft_Excel_Di
rections_For_Beginners.htm) 

 
Techsmith - You can get SnagIt 10, an outstanding screen 
capture program, and Camtasia Studio 7, to quickly record, edit 
and publish multimedia demos and presentations, bundle for 
$269, an $81 savings:  https://store.techsmith.com/government.asp. 
You can download SnagIt 10 alone for $42.95. 

 
THE JANUARY 2012 CLUB RAFFLES 

 
GENERAL DRAWING PRIZES*:  
� LG Blu-Ray DVD Burner User Group Offers - Books and Magazines  
� 100-Pack of DVDs  
� 55-Piece Screwdriver Set Pearson Education Products including Prentice Hall 

Professional, Addison-Wesley Professional, IBM Press, Exam 
Cram, Que Publishing, and Cisco Press.  Get 35% off list price 
by purchasing directly from the publisher combo site: 
www.informit.com/join.  Sign in or create an account.  Enter 
the membership code “USERGROUP” (all caps).  Select your 
items and check out.  You are required to register and apply the 
code once, but you must be logged in to receive the special 
pricing. 

� Plus other goodies 
* Parking stubs are good for two raffle tickets each! 

See the article immediately below this list! 
 
MEMBERS-ONLY DRAWING PRIZES: 
(Wear your NOCCC Badge and get a free ticket!) 
� Epson All-in-One Printer 
� Velleman Digital Multimeter 
� USB Hub  
� Plus other goodies O’Reilly Books - Get 40% off all books and videos from 

O’Reilly, Microsoft Press, Pragmatic Bookshelf, and SitePoint, 
or 50 % off  books you purchase directly from O’Reilly.  Just 
use code DSUG when ordering online, www.oreilly.com/store/, 
or by phone, (800) 998-9938.  Free ground shipping on orders 
$29.95 or more in the US.  If for any reason you are not 
completely satisfied with your purchase, you can return it to 
O’Reilly and get your money back; see 
www.oreilly.com/oreilly/cs/guarantee.  A return shipping label 
is included with every direct purchase and directions are posted 
online in case you misplace it. 

 

Save Your Parking Permits! 
 

o offset the cost of parking in the Lastinger Underground 
Parking Structure, the NOCCC Board approved a motion 

to give each member two NOCCC General Drawing raffle 
tickets in exchange for the Lastinger-parking permit.  Turn the 
bottom-half “receipt” part of your permit to the Rafflemeister on 
the same day or hold it until the next meeting.  Gerry Resch, 
the Raffle Leader, will exchange it for two raffle tickets. 

T

  
Peachpit Press Books Discount - Get 35% off by joining the 
Peachpit Club. Use the following hyperlink to sign up: 
http://memberservices.informit.com/my_account/login.aspx?partner=52 to 
sign up as a member.  User group members should note that 
once you have become a Peachpit Club member, you might use 
your user group coupon code ON TOP of the permanent savings 
you earn as a member of the club.  Just log into the site before 
you make a purchase to ensure this permanent discount will be 
in effect, and then enter coupon code UE-23AA-PEUF (case-
sensitive) at checkout!  This coupon code is an exclusive offer 
that may not be used in conjunction with any other coupon 
codes.  The offer applies to all titles at peachpit.com including 
New Riders, Macromedia Press, Adobe Press, and Peachpit. 

The reason for this is that the NOCCC Board has found that 
some people are not attending meetings or not renewing their 
memberships because of the parking situation.  Chapman 
University has allowed us to park in the Lastinger Parking 
Structure under Wilson Field for only $2 for the whole day of 
our meeting; normally $2 is good for only two hours.  The 
advantages of parking there are clear; you don’t have to drive 
around looking for a legal spot (remember, don’t park on the 
private home side of the street), the car doesn’t get hot and you 
don’t have to parallel park.  There is even an elevator available 
to get down to the parking area.   
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he NOCCC Consignment Table in the 
lobby of Irvine Hall will not be 
available during the January 2012 

meeting.  It is open on even months, the 
same as the  E-Waste collection.  
 For your information: 

1) Only current members can place items 
for sale, but non-members are welcome 
to purchase items from the table.  This is 
a great place to get some money for 
your surplus computer items, and help 
the NOCCC at the same time. 

2) The consignment table operates on a 
90/10% basis — with the owner getting 
90%, and the Club treasury 10%. 

3) You can fill out a Consignment Table 
User List and item tags at the table:  
The user list and each tag must contain:  
a) Seller’s name 
b) Seller’s NOCCC membership 

number 
c) Item name and description 
d) Item asking price 

4) The seller may pick up all items and/or 
money at any time, but no later than 2 
p.m. on the day of sale.  Any items 
and/or money not picked up by 2 p.m. 
will become the property of NOCCC 
and will be subject to disposal at the 
Club’s discretion.  The club has no 
storage room available for unsold items 

5) NOCCC is NOT RESPONSIBLE in any 
way for items bought and/or sold at the 
Consignment Table.  Each item is 
placed and sold on an AS-IS BASIS. 

California disposal laws have made it illegal 
to put monitors and computers in the regular 
trash.  Omni Technics, Inc. will be at our 
regular meetings to collect E-Waste on even 
months, so save your “junk” 'till February.   
Check their web site for more information: 
http://www.ca-recycle.com/.  Or, call 
(562) 627-1910. 

The area code for the following phone numbers is 714 unless noted. 
President 

Jim Sanders ........................ .544-3589..................    president@noccc.org 
Vice President 

Open......................................  
Secretary 

Ted Littman………………...779-1936……………. secretary@noccc.org 
Treasurer  

John Heenan ........................ .998-7660...................... treasurer@noccc.org 
 

Directors 
Dr. Patricia Adelekan............. 628-9844             . p_adelekan@yahoo.com 
Dr. Don Armstrong.................773-1187............ docarmstrong@gmail.com 
Steven Breitbart................... ..486-3070……........ sbreitbart@socal.rr.com 

    Dallas Hazleton........................526-1592...    ghazleton4@dslextreme.com  
Ben Lochtenbergh……..(949) 653-2545…...….......……...  bal@msn.com 
Richard Miller ..................... ...309-1504...............  r r rmil@gmail .com 
Gerry Resch ........................ ...772-6667.............    gerry@gerryresch.com 
Gordon E. Strickland, Jr...........970-7730......... gestrickland@earthlink.net 

 

Editor 
Ted Littman... ...................... ...779-1936........ ..............    editor@noccc.org 

 
Webmaster 

Jim Sanders, Acting……….....544-3589…….…...… president@noccc.org 
 
Volunteers, Committees, and Projects 

 

 Consignment Table 
Richard Miller ..................... ....309-1504................. r r rmil@gmail .com 

 Raffle Leader 
    Gerry Resch ……………….....772-6667...............   gerry@gerryresch.com 
 Helpline 

Ted Littman......................... ....779-1936..............    tedlit@roadrunner.com 
 Membership Database 

John Heenan ........................ ....998-7660..................... treasurer@noccc.org 
 Membership Chairman 

Ben Lochtenbergh...........(949) 653-2545............................... bal@msn.com 
 SIG Coordinator 

Dallas Hazleton .................. ....526-1592........ ghazleton4@dslextreme.com 
 Programs/Speakers Coordinator 

Open 
 Public Relations. 

Open 
 University Liaison  
Jim Sanders.............................. ....544-3589....................  president@noccc.org 
 
Chapman U. Campus Security   997-6763       open locked rooms, problem

T 
Consignment NOCCC Officers 

 E-Waste Collection  

NOCCC is a Member 
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NOCCC Help Volunteers 

 
The Help Line is in the true spirit of the NOCCC, which is to help others to learn more about computers.  The 
following is a list of Help Line subjects that a NOCCC volunteer is able to help you deal with.  Call 
(714) 779-1936 or e-mail Ted Littman at helpline@noccc.org with additions, 
deletions, or corrections.  Most volunteers prefer being contacted by e-mail. Mention 
NOCCC in the Subject line. 

Apple II Gerry Resch 714-772-6667 gerry@gerryresch.com 
Computer Boards Martin LaRocque 562-697-4318 6 - 9 p.m. 
Corel Draw Larry Klees 714-879-7962 larryklees@yahoo.com 
Digital Photography Larry Klees 714-879-7962 larryklees@yahoo.com 
Excel  Gerry Resch 714-772-6667 gerry@gerryresch.com 

The names of our 
volunteers are 
only available in 
the printed 
version of the 
Orange Bytes. 

GPS Navigation Bob DeWolf 714-879-8269 rsdewolf@adelphia.net 
Linux Bob Ray 714-634-7520 bobsdesk@dialup4less.com 
Lotus 1-2-3 Gerry Resch 714-772-6667 gerry@gerryresch.com 
Memory/Interrupts Martin LaRocque 562-697-4318 6 - 9 p.m. 
Microsoft Office John Heenan 714-998-7660 heenanjc@sbcglobal.net 
PC Hardware Jim Sanders 714-544-3589 jsanders@ligasmicro.com 
Photo editing & Pshop Larry Klees 714-879-7962 larryklees@yahoo.com 
QuickBooks - all ver. Linda Russell 909-949-4930 qbqueen@verizon.net 
Tcl/Tk & UNIX Bob DeWolf 714-879-8269 rsdewolf@adelphia.net 
Windows 7, Vista & XP Jim Sanders 714-544-3589 jsanders@ligasmicro.com 
Windows 9X & XP John Heenan 714-998-7660 heenanjc@sbcglobal.net 
WiFi & Networking Jim Sanders 714-544-3589 jsanders@ligasmicro.com 
 

Do you want to be an NOCCC Help Volunteer and assist other members with computing subjects that you know well?  
If so, please contact Ted Littman at tedlit@roadrunner.com or (714) 779-1936. 
 

SIG Leaders  

Contact the SIG leaders by e-mail, preferably, rather than by telephone. 

 SIG BLDG RM. TIME LEADER E-MAIL PHONE  
Linux for Desktop/Admin……….Science……131      9:00/10:30 ..............Bob Ray...........................  bobrobo@dialup4less.com (714) 634-7520 
Beginner’s Digital Photography Science…….127………....9:00………….John Krill.....……………     noccc.bgphotosig@gmail.com   (949) 497-8658 
Visual Programming Science........ 111..............9:00 ...............Anson Chapman…………  aec@cclift.com                     (909) 860-9515 
Come and Share Science........ 109..............9:00 ...............Dr. Patricia Adelekan.......  p_adelekan@yahoo.com (714) 628-9844 
Word, Excel, & Outlook Science........ 306............ 10:30................Tia Christian.....................  Iwilliams_00@yahoo.com             (714) 263-6105 
Mobile Computing Science........ 109............10:30 ...............Ben Lochtenbergh ...........  bal@msn.com (949) 653-2545 
Access/Excel VBA Science........ 306............10:30 ...............Bob Dickson ....................  robertbdickson@socal.rr.com (714) 539-1304 
Advanced Digital Photography Science........ 127   .........10:30 ...............Larry Klees ......................  larryklees@yahoo.com  (714) 879-7962 
Understanding OS’s Science........ 111............10:30 ...............Charlie Moore..................  mooreca@roadrunner.com (714) 529-9071 
Access Science........ 306............12:00 ...............Bob Dickson ....................  robertbdickson@socal.rr.com (714) 539-1304 
PC Q&A Irvine Hall…………10:30/12:30 ...............Jim Sanders ....................  jsanders@ligasmicro.com (714) 544-3589 
Please report SIG changes to Ted Littman, editor@noccc.org, or (714) 779-1936. 

 Contact the SIG leaders by e-mail, preferably, rather than by telephone. 
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Computer Talk 
Word Tips 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net. 

Resize Graphics  Outside of  Word 
As mentioned in other issues of WordTips, Word has a feature 
that allows you to easily resize graphics to almost any size you 
want. While this can be easy to do, resizing graphics in this 
manner may not be the best approach to working with your 
graphics. 

One WordTips subscriber reports the experience of their 
company when it comes to graphics. He works as an instructor 
and technical support staff in a company that produces a lot of 
reports. Many of the reports include lots of graphics: photos, 
drawings, charts, etc. Very often the employees would 
experience problems printing graphics. Every time a problem 
cropped up and the root cause was tracked down it had to do 
with graphics that were resized within Word. Even if the graphic 
was only resized a few percentage points, it could still cause 
problems. 

Sometimes the printing problems could be solved by trying to 
print to a different printer or from a different computer that uses 
different printer drivers. Other times the problem could not be 
solved at all within Word. Regardless, solving the problem 
could take quite a bit of trial and error and therefore a lot of 
time. 

When you insert a graphic in Word and then resize it, the full, 
large-scale graphic is still embedded within your document. 
This adds to the overall size of your document and means that 
the document may be slower or more difficult for Word to 
process. 
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Word is not a graphics program. (Duh!) It makes sense that 
specialized graphics programs would be more adept at resizing 
and cropping graphics than what you can get when you use 
Word. Therefore, you should consider resizing your graphics in 
a graphics program before placing them in a Word document. 
Doing so may result in a higher-quality graphic in your 
document, and it certainly will result in a lesser processing 
burden on Word. 

If you are having problems printing graphics within Word, 
consider resizing and processing the graphics outside of Word 
completely using a program such as Paint Shop Pro or 
PhotoShop. Chances are good that you can solve your problems 
sooner than you think. 

Non-breaking Em Dashes 
Word allows you to enter many different typographical symbols, 
among them en dashes and em dashes. Exactly how you create 
these types of dashes has been covered in other issues of 
WordTips. However, it should be noted that an em dash may not 

work exactly as you want it to. Normally an em dash is placed 
in a document between two words. In other words, there are 
typically no spaces around an em dash. (An en dash may be a 
different story that we won't get into in this tip.) 
For those readers who are editors and/or typographers, a quick 
side-trip may be in order here. (For those who don't fall into this 
category, please excuse this tangent, but I know from sad 
experience that debating punctuation can be a somewhat 
religious experience.) Some of you may take exception to the 
claim of no surrounding spaces. Just so you know, I am relying 
on The Chicago Manual of Style for my reference here. It 
indicates that a space may follow or precede (but not follow and 
precede) a 2-em dash to indicate missing letters or spaces can 
appear on both sides of a 3-em dash to indicate missing words. 
Both of those instances are beyond the scope of this tip; here we 
are talking about single em dashes. 
Meanwhile, back in Word-land, an em dash is always sticky to 
the word it follows. Thus, in the phrase "John—the original 
author—was flabbergasted," the em dashes will always stay 
with the words John and author as the end of a line is reached. 
In this way, an em dash can appear as the last character on a 
line, but never as the first character on a line. 
If you want your em dashes to be sticky on both ends (sort of 
like a very long non-breaking hyphen), then you may be out of 
luck. Many people get around the problem by putting two, three, 
or even four non-breaking hyphens in a row to simulate a non-
breaking em dash. The problem with this solution is that the 
non-breaking hyphens end up looking like a dashed line, not a 
solid em dash. You can minimize or virtually eliminate the 
natural spaces between the non-breaking hyphens by following 
these steps: 

1. Select the non-breaking hyphens. (This technique 
works best if you use four non-breaking hyphens.) 

2. Display the Font dialog box. (Choose Format | Font or, 
in Word 2007, press Ctrl+D.) 

3. Make sure the Character Spacing tab is selected. (See 
Figure 1.)  

 

Figure 1. The Character Spacing tab of the Font dialog box. 

http://word.tips.net/
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4. Using the Spacing drop-down list, choose Condensed. 
The By field to the right of the Spacing drop-down list 
should change to 1 pt. 

5. Change the By field to 1.2 pt. (You may have to play 
with this figure based on the font you are using.) 

6. Click on OK. 
The result is four characters (all non-breaking hyphens) that 
appear as a single character since they basically overprint each 
other just a bit. You can also take these four characters and 
assign them to an AutoText or AutoCorrect entry so they will be 
easy to use in the future. 
You can also take a little different approach to the issue: You 
can stretch characters instead of condensing spacing. If you 
want to take this approach, simply insert a single non-breaking 
hyphen between your words, then follow these steps: 

1. Select the single non-breaking hyphen. 
2. Display the Font dialog box. (Choose Format | Font or, 

in Word 2007, press Ctrl+D.) 
3. Make sure the Character Spacing tab is selected. 
4. Using the Scale drop-down list, choose a high value, 

such as 200% to 400%. (You may have to play with 
this figure based on the font you are using.) 

5. Click on OK. 
Finally, you can insert a symbol to use instead of the regular em 
dash used by Word. This symbol will be sticky on both ends, 
unlike the em dash. Follow these steps: 

1. Position the insertion point where you want the non-
breaking em dash. 

2. Display the Symbol dialog box. (See Figure 2.) Click 
Insert | Symbol or, in Word 2007, display the Insert tab 
of the ribbon, click Symbol, and then More Symbols. 

 
Figure 2. The Symbol dialog box. 

3. Using the Font drop down list, choose Normal Text. 
4. Using the Subset drop-down list, choose General 

Punctuation. The character selected should be the en 
dash. 

5. Press the Right Arrow key once. The character selected 
should be the em dash. 

6. Press the Right Arrow key on e more time. This is the 
character you want. 

7. Click Insert. 
8. Click Cancel. 

With all these potential solutions, there is one caveat of which 
you should be aware. The spelling and grammar checkers in 
Word knows how to handle the regular em dash; they don't 
know how to handle these workarounds. Thus, don't be 
surprised if one of the checkers treats the word-dash-word 
combination as a single word and flags it as incorrect. (Just a 
little warning so you don't rely on Word to catch your spelling 
errors in this instance.) 
 
Working with Other People's  Fi les  
If you work in an office where Word is used, it is likely that you 
need to work with documents from other people. If you simply 
load up their document, then you have to put up with their 
formatting choices. This may be hard to do, especially if you 
don't like their choices in fonts or spacing. To overcome this, 
open a new file (based on the template of your choice) and 
insert their file in this new document. If there are any styles in 
their document that match names in your document, then your 
styles will take precedence. Thus, your formatting choices will 
be used, not theirs. 
Note that this tip will not work if styles were not used in the 
original document. If the other person explicitly formatted text 
using the menus or ribbon, then the formatting they used will 
remain. To overcome this, you may want to select the entire 
document and reset it to the Normal style. 
 
Delet ing a Header or Footer 
If you want to delete the headers or footers defined in your 
document, follow these steps: 

1. Position the insertion point in the section that has the 
header you want to delete. 

2. Display the Insert tab of the ribbon. 
3. In the Header & Footer group, click either Header or 

Footer, depending on which one you want to delete. 
Word displays a drop-down list of options. 

4. Click Edit Header or Edit Footer, depending on which 
tool you clicked in step 3. Word displays the header or 
footer along with the Design tab of the ribbon. 

5. Select the contents of the header or footer. 
6. Press the Del key, or press Ctrl+X. 
7. On the Design tab of the ribbon click on Close Header 

and Footer. 

You may wonder why you don't just click Remove Header or 
Remove Footer, options available after you complete step 3 of 
these steps. The reason is simple—in my testing, clicking those 
options removes the header or footer text, but it doesn't remove 
the header or footer paragraph. Thus, if you have (for instance) a 
header or footer that includes a paragraph border, that border is 
still visible after you use the Remove Header or Remove Footer 
tools. The only way to get rid of the entire thing is to follow the 
steps as outlined. 

If you are using a version of Word prior to Word 2007, follow 
these steps instead: 



1. Position the insertion point in the section that has the 
header you want to delete. 

2. If you are using Normal or Outline view, choose 
Header and Footer from the View menu. In Print 
Layout view, you can simply double-click on the 
Header or Footer you want to delete. You will see the 
Header and Footer dialog box, and the header area of 
the page. 

3. If you want to delete the footer, click on the Switch 
icon in the Header and Footer dialog box. 

4. Select the contents of the header or footer. 
5. Press the Del key, or press Ctrl+X. 
6. Click on Close. 

 

Excel Tips 
 
Copyright © 2011by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net. 
 
Capturing a Screen 
There may be times when you need to include a screen shot 
within your Excel worksheet. The easiest way to do this is as 
follows: 

1. Set up your screen to look the way you want it to. 
2. Press the PrintScreen key. This copies the screen to 

the Clipboard. 
3. Start Excel (if it is not already started) and select the 

cell closest to where you want the screen to appear. 
4. Press Ctrl+V to paste the contents of the Clipboard. 
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This action results in the entire screen being pasted in your 
worksheet. If you wanted, instead, to only copy and paste a 
single dialog box or the active window, simply use 
Alt+PrintScreen in step 2. 

If either of these methods still does not fit your needs (for 
instance, you want to include only a small part of the screen), 
you can use the following: 

1. Set up your screen to look the way you want it to. 
2. Press the PrintScreen key. This copies the screen to 

the Clipboard. 
3. Start the Paint accessory (or some other graphics 

program) and maximize the screen. 
4. Press Ctrl+V to paste the contents of the Clipboard 

into the program. 
5. Use the program's editing tools to change the image as 

desired. 
6. When complete, press Ctrl+C to copy the image to the 

Clipboard. 
7. Start Excel (if it is not already started) and select the 

cell closest to where you want the screen to appear. 
8. Press Ctrl+V to paste the contents of the Clipboard. 

You should understand that once the screen is placed in your 
workbook, you can move and manipulate it the same as any 

other graphic. Also note that adding quite a few graphics to your 
worksheet can dramatically increase the size of the file in which 
your workbook is saved. 

Moving Cel l s  Us ing  the  Mouse  
As you edit your worksheet, you can use the mouse to move 
cells from one location to another. You do this by following 
these steps: 

1. Select the range of cells you want to move by 
highlighting the range with the mouse. 

2. Position the mouse pointer over the heavy border that 
surrounds the selected range. The pointer should turn 
into an arrow. 

3. Click and drag the range to a new location. As you 
move the mouse, the outline of the range moves. 

4. When you are satisfied with the new location, release 
the mouse pointer. The cells are moved. 

If there is anything already at the target location, Excel may ask 
you if you want to overwrite the existing cells. You can respond 
according to your desires. 

If you cannot seem to edit this way, or if no heavy border (step 
2) appears around your selected range, then drag-and-drop 
editing is probably turned off on your system. To check this, 
follow these steps: 

1. Choose Options from the Tools menu. This displays 
the Options dialog box. 

2. Click on the Edit tab. (See Figure 3.)  

Figure 3. The Options dialog box. 

3. Make sure the Allow Cell Drag and Drop check box is 
selected. 

4. If you want to be warned before overwriting 
information during an edit, make sure the Alert Before 
Overwriting Cells check box is selected. 

5. Click on OK. 

http://excel.tips.net
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Fitt ing Your Information 

It is important to remember that the default size for Excel 

columns is only a starting point. In fact, one of the most 

common formatting tasks you will do in Excel is to adjust the 

width of columns. If you want to make sure that all the 

information in a cell is visible, try this: 

1. Select a cell in the column you want to adjust, making 
sure you select the one that has the widest information 
you want displayed. 

2. Choose Column from the Format menu. This displays a 
submenu. 

3. Choose AutoFit Selection from the submenu. 

The column width is adjusted so that the information in the cell 
you selected is entirely visible. Another quick way to do a 
similar adjustment is to simply double-click on the divider bar 
between the column heading for the column you want to adjust 
and the column to the right. That may sound confusing, but it is 
really quite simple. For example, let's say you wanted to adjust 
the width of column D. All you need to do is double-click on the 
divider bar between D and E in the gray column headings at the 
top of the worksheet area. 

There is one difference between these two methods. If you use 
the AutoFit Selection method, the width is set based on the cell 
you have selected. If you use the double-click method, the width 
is set based on the widest item in the column, not what you have 
selected. 

Arranging Workbook Windows 
If you have more than one workbook open at a time, Excel 
allows you to view all the workbooks at the same time, and to 
arrange each window as you desire. The easiest method of 
arranging workbook windows is as follows: 

1. Choose Arrange from the Window menu. Excel 
displays the Arrange Windows dialog box. 

2. Make sure the Tiled option is selected. (This divides 
the screen space evenly between all your windows. The 
main benefit is that all your workbook windows get at 
least a piece of the screen.) 

3. Click on OK. The windows are all displayed. 
4. Click on the window whose size you wish to adjust. It 

becomes active. 
5. Move the mouse cursor near the border of the active 

window. When the cursor turns into a set of arrows, 
press the mouse button and drag the window edge to 
the desired size. Release the mouse button. 

6. Repeat steps 4 and 5 for each window you want to 
adjust. 

 

Forcing a Page Break 
As your worksheet gets larger, there may be times when you 
want to force Excel to starting printing on a new page. For 
instance, you might want only the first fifteen rows of 
information on the first page, then the balance of the worksheet 
on the second printout page. To make this happen, follow these 
steps: 

1. Make sure cell A16 is selected. 
2. Choose Page Break from the Insert menu. A dashed 

line appears between rows 15 and 16. 
3. Print your worksheet as normal. 

If you want to later remove the page break, follow these steps: 

1. Make sure cell A16 is selected. 
2. Choose Remove Page Break from the Insert menu. The 

dashed line disappears. 

Changing the  Color  of  Worksheet  Gridl ines  

Most people using Excel leave the gridlines visible so that they 
can easily see where the various cells are. By default the 
gridlines are a light gray. You can easily change the gridlines to 
a different color by following these steps: 

1. Display the Excel Options dialog box. (In Excel 2007 
click the Office button and then click Excel Options. In 
Excel 2010 display the File tab of the ribbon and then 
click Options.) 

2. Click Advanced at the left side of the dialog box. 
3. Scroll through the options until you see the Display 

Options for this Worksheet section. (See Figure 4.)  

Figure 4. The Advanced options of the Excel Options dialog box. 

4. Ensure the Show Gridlines check box is selected. 
5. Using the Gridline Color drop-down list, choose the 

color you want to use. 
6. Click OK. 



 
 

Backup Your Device Drivers? 
“Is it necessary to back up my device drivers?” Fo
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r Bob’s 
answer, go to: 
http://askbobrankin.com/backup_your_device_drivers.html?awt
_l=DGqD3&awt_m=JhL3yVNSi8P6SL 
 
Computer Backup Power  
“What do you recommend as a backup power supply for 
computers?” For Bob’s answer, go to: 
http://askbobrankin.com/computer_backup_power_.html#ixzz1e5LhRFOO 
 
Wireless  Data Storage Devices  
“I've recently heard about wireless portable hard drives, and am 
thinking about using one as a backup drive.” For Bob’s 
recommendations, go to:  
http://askbobrankin.com/wireless_data_storage_devices.html#ixzz1e5MajZaD 
 

Ed’s Tips 

 

Windows 7 Search tool   
“We occasionally want to locate a file on our computer. Can 
you recommend a good way to search? Do we need another 
program?” For Ed’s answer go to: 
http://edwardns.com/blog/windows-7-search-tool 
 
Using Windows Homegroups 
“We have 2 Windows 7 PCs in our home and would like to 
share files between them. What are Homegroups and can [...]” 
For  Ed’s  answer ,  go  to :  
h t t p : / / e d w a r d n s . c o m / b l og / u s i n g - w i n d o w s - h o m e g r o u p s  
 
Access  email  from multiple  PCs  
“ I have 3 PCs running Windows 7 and I use Outlook 2007 for 
email on all 3. Is there a way to sync my email for all three 
computers?” For Ed’s answer, go to: 
ht tp: / / edwardns .com/b log /access - emai l - f rom-
mul t ip le -pcs  
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at the NOCCC Website. 
Webmaster Needed! 

reitbart, NOCCC By Steven B

Jim Sanders, the NOCCC President, has been updating the 

le in PDF 

NOCCC web site.  Nevertheless, we urgently need a 
volunteer to be the Webmaster.  If you can help, contact Jim 
Sanders at president@noccc.org or (714) 544-3589. 
 

e latest issue of the Orange Bytes is now availabTh
format, in color and with live internal and external links.  There 
is no user name or password needed.  Older issues also are 
available.  Go to our website: http://www.noccc.org/bytes/index.html.. 
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Products Available for Review 
he NOCCC regularly receives copies of books and 
software from vendors for our review.  We can also 
request specific products for you to review.  These 

reviews are published in this newsletter, the Orange Bytes.    
Then, you get to keep the book or software.  If you are 
interested in doing a review, please call or send me an e-mail 
and provide your membership number, phone number, and e-
mail address. You can pick up the product in the lobby of 
Irvine Hall between 9 A.M. and Noon at the next NOCCC 
meeting. 

 
Ted Littman, (714) 779-1936, reviews@noccc.org. 

Note to Reviewers 

� You have 2 months to submit a review. Due-cause time 
extensions must be requested from the Reviews Editor. 

� You must leave a security deposit (check, credit card 
number, or cash equal to the product’s list value.), 
returnable upon our receiving an acceptable review. 

� If you decide to return the product without reviewing, 
there is a $2 penalty after the first month and a $5 
penalty after the second month. 

� Guidelines for preparing your review are addressed on 
the next page.   

 

Books 
Operating Systems & Computing 
 
Computers for Seniors for Dummies – Choosing the right 
computer and learning how to use it. By Nancy Muir from 
Wiley. MSRP=$25. 
Social Networking & Internet 
 
New: The Internet for Dummies – Authored b7 Levine & 
Young from Wiley. MSRP=$25. 

New: The Facebook Guide for People Over 50 – Seniors learn 
how to get connected. Book by Paul McFedries from Wiley. 
MSRP=$20. 
 
New: Facebook Me! 2nd Ed. – A guide to socialixing, sharing, 
and promotingon Facebook. By David Awl. From Peachpit 
Press. MSRP=$22. 
 
Twitter for Dummies – How to connect with others in 140 
characters. Book by Fitton, Gruen, & Poston from Wiley. 
MSRP=$22. 
 
New: Twitter Marketing for Dummies – Use Twitter to build 
your network, spread your message, & communicate with your 
customers. By Kyle Lacy from Wiley. MSRP=$25. 
 
New: LinkedIn for Dummies – How to join & use the largest 
online network for professionals. By Joel Elad from Wiley. 
MSRP=$25. 
 
New: Mom Blogging for Dummies – Learn how to set up your 
blog and use it to sell your products & services. From Wendy 
Piersall from Wiley. MSRP=$25. 
 
New: The Back Channel – How audiences are using social 
media & changing presentations forever authored by Cliff 
Atkins. From New Riders. MSRP=$35. 
 
Mining the Social Web – Analyzing data from social media 
sites by Matthew Russell. From O’Reilly. MSRP=$40. 
 
Digital Photography & Design 
 
New: The Portrait Photography Course – Principles, 
practices, & techniques. By Mark Jenkison, from Peachpit 
Press. MSRP=$40. 
 
New: Professional Portrait Retouching Techniques for 
Photographers using Photoshop – Learn how the pros do it. 
By Scott Kelby, from New Riders. MSRP=$50. 
 
Canon PowerShot G12 – From snapshots to great shots by Jeff 
Carlson from Peachpit Press. MSRP=$25. 
 
The Photoshop Elements 9 Book for Digital Photographers – 
New Riders book by Scott Kelby & Matt 
Kloskowski.MSRP=$50. 
 
New: Adobe InDesign CS5 Classroon in a Book – The official 
training workbook from Adobe Systems. Includes a CD. From 
AdobePress. MSRP=$55. 
 
Real World InDesign CS4 – This book covers the waterfront 
on Adobe’s new design suite. Authored by Olav Kvorn & David 
Blatner, it is published by Peachpit Press. MSRP=$55. 

T 

Reviews Editor’s Corner 
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Product Reviews 
Degunking Windows 7 There are lots of figures (screen shots) to accompany the text; 

unfortunately, some use a font size that will give you eye strain. 
In addition, a few of the recommendations are controversial, like 
cleaning (or even opening) the Registry. Even with the caveats 
that Joli offers, most computer users should not go there without 
the help of an expert. Efficiency can be overdone and cause an 
enormous waste of time in reconstituting a system that has been 
screwed up by an inexperienced person. 

 
Book Review by Ted Littman, NOCCC 

Author: Joli Ballew 
Publisher: McGraw Hill, Feb. 2011, 
ISBN-10:0071760059, 278 pages. 
 
Price: $25 list, $16 at amazon.com.   
 Surprisingly, the author did not make a recommendation on who 

should read the book; however, John Iasinolo, who wrote the 
book’s Foreword, stated this book “is written for everyone, from 
novices to professionals!” I don’t think it will appeal to the 
gurus or those folks who are unwilling to bother with anything 
except the bare minimum in PC housekeeping (or those who 
don’t do books). For the most part, the book was enjoyable to 
read although a bit repetitious. The author has an easy-to-read 
writing style and injects sufficient humor to keep your attention. 
And she has credible credentials! These include authoring her 
first “Degunking Windows” book in 2004. 

According to the publisher: 
“Degunking Windows 7 is the fast, 
affordable way to keep your 
computer running quickly and 
efficiently. Over time, Windows 
PCs can slow down due to 
unnecessary programs, files, errors, 

and other ‘gunk.’ This book's proven Degunking 12-Step 
Program shows you how to organize your hard disk, load and 
run only the programs and processes you need, and restore the 
speed, responsiveness, and reliability your PC had when it was 
brand new. This do-it-yourself guide puts the practical 
information the expert PC technicians know directly into your 
hands, saving you lots of time and money!” 

 
However, I do think that there is too much emphasis on using 
the operating system’s built-in tools and those that are free. 
From my experience, there are lots of pay programs available 
that work much better than the ones Microsoft provides. If one 
is willing to invest many hundreds to thousands of dollars in a 
PC, then allowing for the expenditure of funds for software and 
peripheral hardware makes sense.  

 
Sounds great, right? Well, in spite of the hype, like calling 
things to be removed from your PC “gunk,” using a “proven  
12-step program” to degunk, and insisting that you start at the 
beginning of the book and work through to the end, following 
most of the practices recommended in the book will have a 
positive impact and give you a faster, more efficient system. In 

 
Should you buy the book? If your computer seems to have 
slowed down due to the accumulation of stuff or if you want to 
avoid the problems associated with housekeeping neglect, and 
you are willing to follow a logical step-by-step procedure, then 
$16 seems like a very reasonable investment. Although the book 
was written for Windows 7, most procedures will apply as well 
to earlier operating systems. 

fact, the author addresses important housekeeping practices that 
have nothing to do with degunking; activities such as 
implementing good security practices as well as regularly  
backing up your data files and defragmenting your hard drives. 
 
I have been computing for over 15 years and, as a retired 
engineer, try to maintain an efficient computer with good 
housekeeping practices. But, I was surprised at how many of 
author Joli’s recommendations I was overlooking. I did read the 
book from cover to cover (but, how else can you write a 
review?) over the course of a week, applying the recommended 
practices that I have not been using. But, it took a lot of patience 
to stick to it – more than the average person probably has, 
especially if you are not retired. To her credit, Joli offers a range 
of time-dependent degunking sets ranging from “spare moment” 
to half-day at a time.  

  
For more information on the book, check out this web site: 
https://www.mhprofessional.com/product.php?isbn=0071760059 
 

Photoshop CS4 Review 
Review By Jim Sanders NOCCC 
 

For a long time, I have 
coveted owning my own 
copy of the gold standard of 
image editing, to wit, Adobe 
Photoshop. Justifying the full 
price of the program, which 
is now up to $999, was a 
little hard to do and certainly 
tough on the pocketbook. As 
a result, I have over the 
years, used a number of 
different editing programs. 
Some were free, because 

they came bundled with a scanner. My first copy of Paint Shop 

 
The book is organized into 14 chapters ranging from what 
causes gunking to backing up files. No major topics have been 
omitted, although some of us might prefer greater coverage of 
some areas. (However, the book does provide numerous 
recommendations on where to go from here.) There also is an 
appendix devoted to housekeeping a new PC; i.e. getting rid of 
some of the so called “crapware” that PC vendors usually install 
on a new system.  
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Pro was version 5 released in 1998. At that time it was owned 
by JASC, which, as a point of historical interest, was an 
acronym that stood for Just Another Software Company (JASC 
was bought by Corel several years ago.) JASC was a presenter 
at the South Western Users Group conference in San Diego that 
year. I was the lucky holder of the winning ticket for that door 
prize. That program was my first introduction to the power of 
layers. 
 
The combination of a presentation on Adobe Photoshop 
Elements that impressed me with its editing power and a good 
sale, with a nice rebate, caused me to open up my wallet for 
version 2 of that program. I have over the years, upgraded both 
of these programs and now own Paint Shop Pro version 13 (X3) 
and Elements version 8. These two programs have been 
upgraded in both power and complexity over the years. Both of 
them present themselves as easier to use than Photoshop and 
aimed at the nonprofessional who does not need all the power of 
Photoshop. 
 
The North Orange County Computer Club has a reviews 
program for hardware, software, and books. The program is 
pretty simple: check out an item, write a decent review on that 
item, and you get to keep the product. An illness prevented the 
person who had originally checked out Photoshop CS4 from 
writing a review, and the item had to be returned and remained 
available for a couple of months after that. Apparently the 
reputation of Photoshop as a very complex program was 
intimidating to potential reviewers. All of that took time and 
overlapped the release of Photoshop CS5. My greed overrode a 
similar reluctance on my part, but I agreed to do a review of the 
Photoshop CS4 program. 
 
My installation system is a Windows 7 machine with an Intel 
2500K CPU, 8 GB of RAM, and an AMD 6870 video card. 
When I opened the box, which is relatively small and light, I 
found a plastic DVD holder containing 2 DVDs and three small 
sheets of paper. One DVD is the Adobe Photoshop CS4 
program installation disk, and the second is a learning disk that 
says it contains over two hours of video on various topics. There 
is no manual or instruction book. In fairness, a comprehensive 
manual on Photoshop CS4 would probably need to be about 2 
feet thick, be cumbersome, and nowhere near as easy to deal 
with as the electronic equivalent. One of those three sheets of 
paper refers to the online help available @ Adobe.com, the 29 
MB help PDF that you can download, the online community, 
the search function on their site, the fact that help is available 
even without an online connection, and the reference to the 
many, many tutorials that can be accessed by searching the web. 
Not to mention the many books, DVDs, and CDs, those are 
available on Photoshop. 
 
The actual installation went very smoothly and only took a few 
minutes. At nearly the completion of the installation you are 
offered one interesting option. You are given the choice of 
entering the serial number of your product or choosing to have a 
30 day trial. A nice thing about that option is that you can see if 
the computer you are installing it on is adequate for your use of 
the program. Once the program was installed, I clicked on 
Adobe Photoshop CS4 (64bit) and the program loaded with 

surprising speed. At one point in the load cycle, a window 
popped up suggesting that I should check to make sure that my 
video card had the latest driver. I learned that this is because 
CS4 will make use of the Graphics Processor Unit or GPU that 
has the necessary attributes to be compatible with OpenGL and 
a couple of other specifications. If the video card meets the 
specifications, CS4 can offload some of the image processing to 
the video card. As it happens, the AMD 6870 meets all those 
specifications with room to spare. One of the features that this 
capability augments is continuous zoom. If you place the zoom 
tool over an object in the image and keep it there while left 
clicking, the program will rapidly zoom into that spot until you 
release the button. When you then click on the “Fit Screen” 
button, the image reverts to its normal size in a flash. 
 
Okay, so I finished the installation, clicked on the start button, 
clicked on All Programs, and found that instead of the one 
program that I expected there were seven entries for CS4. There 
was both a 32-bit and the 64-bit version of Photoshop CS4 and 
several support programs. A notable one is Adobe Bridge CS4. 
This is a file management and file organization program that is a 
pretty important function all unto itself. It can be an integral part 
of establishing a workflow system that is very useful if you are 
dealing with a large number of photographs. Beyond that I will 
not comment on Bridge.  I started the Photoshop program; it 
fired up with a blank workspace, the tools panel on the left, the 
menu bar at the top, and the panel's column on the right. First 
thing is to have some image to work on. Going to File and Open 
is a no-brainer and navigating to the directory that you want is 
pretty standard. With the image open, the first thing that I did 
was play with the above zoom feature. Fun, impressive, useful 
even, but for all that, not a big deal. So with the image loaded, 
the question becomes one of, what can Photoshop do with the 
image that I think needed doing? After several hours of study, it 
becomes easy to change the question to one of “What can't 
Photoshop due to an image?” Initially, I was so overwhelmed 
with available options and the lack of knowledge on how to use 
them that I wasn't sure where to start other than Help! Clicking 
on Help takes you online to the adobe.com website and 
specifically to the Adobe page titled Using Photoshop CS4.  
This is part of the electronic equivalent of the manual that is not 
in the box. It starts with some basics, and the section on the 
Workspace, I found particularly useful. Somewhere in that area 
I also found a reference to the fact that you can download a 29 
megabyte, 700 page long PDF manual file. The PDF manual is 
quite useful if you are not able to go online for some reason. 
 
After spending several hours reading various parts of those 
documents, and watching a number of the training videos on the 
second DVD that was in the box, I decided to search the web for 
tutorials. Most of these tutorials seem to be on YouTube. They 
ranged from complex and complicated tasks to lighthearted or 
whimsical and in a few cases salacious. A problem with a large 
number of these tutorials is that they have been edited to save 
time. So while they may show what step was taken to change 
the tool for the next step, that only lasts for a few frames and I 
found it very difficult to follow what was being done in many 
cases. A Google search on “how to single frame step YouTube” 
solved the problem. 
 



At this point in its development, Photoshop has more tools than 
most people know what to do with. I find that I can understand 
how to use most of the tools to achieve their primary function. 
What a number of the video tutorials make very clear to me, is 
that to become truly adept at using Photoshop, I need to develop 
a feel for the synergy that comes from using multiple tools in 
combination with each other. More often than not, the synergy 
is exemplified in the combination of multiple tools and; in bold 
letters and all caps...........LAYERS! If you can learn and 
understand layers, you are halfway home to becoming a 
Photoshop guru. 
 
I now have an image toolbox, Photoshop, that can do just about 
anything that can be done to an image if the user learns how to 
use the tools. Do I need that capability, most of the time, 
probably not. Paint Shop Pro or Photoshop Elements or even 
some of the lesser programs might be adequate for a lot of the 
common tasks. Even for a lot of professionals, Photoshop 
Elements may do just about everything that they need done. For 
some amateurs, there may be a particular task that only 
Photoshop provides an answer for. If I had to spend the $999 list 
price for Photoshop, I would probably pass. However, there is a 
good way to get the program for 20% of that price. A large 
number of community colleges offer a course on the use of 
Photoshop. Not only is taking one of those courses a good idea, 
but in a large number of cases it also qualifies you for getting 
the student discount price on Photoshop which is $199.00 
MSRP. 
 
Adobe Photoshop Extended CS5 is available from Amazon.com 
for the discounted price of $961.89 and that includes free 
shipping. The Adobe Photoshop Extended CS5 Student and 
Teacher Edition is available for the discounted price of $149.99, 
which includes shipping. If you can qualify for the student 
edition at that price, I would strongly recommend that you do 
so. Photoshop really is an amazing piece of software. 
 
 

Real World Adobe Photoshop CS5 
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For Photographers  
Book Review by Jim Sanders, NOCCC 

 
This book by Conrad Chavez is 
nearly 600 pages long and 
could probably be 10 times that 
long and still not cover in detail 
everything Photoshop can do, 
but it tries. The title would 
probably be a little more 
accurate if you were to insert 
“Professional” in front of 
Photographers in the title. I am 
a reasonably knowledgeable 
amateur photographer with 40 
years of on-the-job training. I 

have used several versions of PaintShop Pro and Photoshop 
Elements. I have long coveted the gold standard to which all 
others compare themselves and recently acquired Photoshop 
CS4. It took very little time to decide that I need help in 
understanding how to use the program. When the opportunity to 

review this book presents itself, I figured there wouldn't be all 
that much difference between CS4 and CS5. That is mostly true, 
but, for instance, the new Content-Aware Fill feature in CS5 is 
impressive.  
 
The skill level this book intends to address, printed on the back 
cover, defines the book as intermediate/advanced, and that is 
pretty accurate from my point of view. The author spends the 
first 100 pages covering setup and several different categories of 
basics. The number of pages he spends on color calibration and 
the different methods of adjustment emphasized the importance 
of this aspect of professional photography. One item that caught 
my eye, and surprised me a little bit, was how adamant he was 
that you really should have a totally separate, fast, scratch disk 
installed in your system, possibly even an SSD.  
 
Whether you are a professional or an amateur, today's digital 
cameras make it both inexpensive and worthwhile to take 
hundreds of images on any given shoot. There are a number of 
potential pluses to having a lot of images to choose from. My 
favorite is finding something in a frame that I wasn't even 
aiming at. The downside is that you have all of those images to 
go through. In addition, most serious photography is now done 
in the RAW mode which increases your post-processing time 
significantly. The author, Conrad, with good reason, is big on 
establishing a digital workflow system. Using Adobe Photo 
Downloader, which is included with Bridge, which is part of the 
Photoshop CS5 package, is a big part of the system he 
recommends. He details how using Downloader, Bridge, and 
Camera Raw to do preliminary processing of images can save 
you a great deal of time. But that's only after you have spent a 
great deal of time learning how to use Camera Raw and Bridge. 
Most of the 130 pages of Chapter 5 deal with how to use 
Camera Raw to make image adjustments. The rest mostly deals 
with how to use Bridge to manage your image files. 
 
Chapter 6 has the mildly misleading title of Essential Photoshop 
Tips and Tricks. The density of information in these 50+ pages 
is pretty high. One of the points made in this chapter is that the 
current versions of Photoshop know how to offload some of the 
processing onto the video card's GPU (Graphics Processing 
Unit). This is somewhat confusing as Conrad made a point in 
Chapter 1 of saying that you really didn't need to spend money 
purchasing a high-end video card of the type that gamers like. 
But it is those self-same cards that have the more powerful 
GPUs. While he mentions that “screen space remains at a 
premium even as monitor sizes grow,” he does not go into how 
the high-end AMD video cards make it very easy to have two, 
three, or more monitors hooked up to your computer and 
arranged as one large desktop. Nonetheless, studying this 
chapter in detail would be very beneficial. 
 
Chapter 7 is titled Image Adjustment Fundamentals. That could 
easily be renamed the Histogram and color adjustment chapter. 
Many examples are provided of both the subtle ways in which 
adjusting the histogram of photos and, in some cases, the 
substantial way in which manipulating the histogram affects 
your photos. This chapter contains several good photos that 
have skewed histograms and illustrates what actions can be 
taken to correct them. I found several of the subtle methods 
illustrated that I want to remember and practice using. 

(continued on page 26) 
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December 4, 2011 
Main Meeting Report 

By Steven Breitbart, NOCCC; photos by John Krill & BenLo 
 
NOCCC President Jim Sanders first opened the meeting with a 
bit of club business.  Tony Loechner can no longer help with the 
production of the Orange Bytes, the club newsletter, so Ted 
Littman, the editor and also our club Secretary is looking for 
help.  The whole issue is printed and mailed to members, but it 
is available in color earlier on the club web site. 
 
Jim also reminded people the club needs a Vice President, one 
of the officers required by the club.  Also, that this current term, 
will be Jim’s absolute last term as club President.  Elections 
will be held at the June meeting.  Please consider joining the 
Board or running for an office. 

Our speaker was Larry 
Klees, leader of the 
Advanced Digital 
Photography SIG and the 
topic was using the photo-
displaying web site 
Flickr.com, which is now 
part of Yahoo!  It is more 
than a site to display your 
photos; it is a photo 
organizing and sharing site 
where you can compare and 
comment on photos made by 
people all over the world!  
Up to 5,000 photos a minute 
are uploaded to Flickr. 
 

The opening screen of Flickr.com is a summary of recent 
events, uploads, comments by other users, etc.  You can upload 
photos in JPG or TIFF format, and unanimated JIF files.  RAW 
is not accepted and the maximum file size per image is 15 MB 
for a free account; paid accounts have a 20 MB limit.  Two 
videos a month of up to 150 MB also can be uploaded; several 
formats are accepted.  With a free account, you can see 200 
images of your “photostream,” the photos you have uploaded.  
There is also a 3-set limit; a set being a grouping of your own 
photos.  There are also a few advertisements displayed.  
However, for $24.95 per year you can see all the photos you 
have uploaded and the 3-set limit is removed.  There are other 
advantages as well; the videos can be up to 500 MB in size.  If a 
person has a Flickr account, he/she can look at anything 
uploaded, if not, someone needs to send them a link to the 
photograph. 
 
Good security exists on who can see or copy your photos.  You 
can choose who can see your photos, and the particular sizes in 
which it is available.  Also, who can download your photos or 
add comments.  The choices are: only you, friends and family, 
your contacts (who can make you their contact or not) or any 
other Flickr member.  Most settings can be applied to individual 
photos or sets in your profile.  There are also favorites, photos 
you have chosen from other photographers that you like to view 
and perhaps download, or comment on frequently, unless the 

settings for that photo are set to prevent comments and 
downloads. 
Groups are photos about specific subjects.  There are over 10 
million Flickr groups, for example: Night Images.  Several 
people run a group, and you submit your photo to the group.  
Groups can be set up to be by invitation only.  Flickr has 
automatic routines which check the photo’s tags (see below) and 
see if they match the group’s criteria. 

 
Sets are groups of your own photos; this is the place you arrange 
the order of the photos.  These can be turned into collections.  A 
Collection can be a large topic, for example: My Trip to Europe, 
with several sets about individual locations within it.  Galleries 
bring photos on a subject together for public viewing from 
multiple photographers.  You can also call up a map and post a 
thumbnail image of a photo at the location it was taken. 
 
You can attach searchable tag words to each photo.  You can tag 
all the photos you have just uploaded, but you can then alter the 
tags for individual photos.  Flickr user names and tags, as 
individual photographers are also searchable.  Groups can also 
automatically add tags if allowed.  Larry normally enters EXIF 
information, such as title, description, and copyright 
information, using a photo editor, which overwrites the default 
name of the photo typically used by Flickr.  It also populates 
several of the tag fields. 
 
Notes can be embedded in a photo, so you’ll never forget 
people’s names or other things.  Separately, you can use another 
tag type field to list the people in the photo. 
 
Other settings include whether the photo can be downloaded can 
be applied globally from your profile, but also to individual 
photos.  There are also favorites, photos you have chosen from 
other groups that can be downloaded unless the settings for that 
photo prevent it.   They also have content filters to prevent 
pornography from being posted where it is not wanted. 
 
Almost all photos, whether in sets or groups, can be quickly 
built into slide shows.  A link can be sent to other people, not 
members of Flickr to view the slide show. There are lots of 
additional capabilities built into Flickr.  I recommend checking 
out the tour of these features at www.flickr.com. 
 
Another interesting meeting.  See you next month. 

http://www.flickr.com


December 4, 2011 Raffle Winners 
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John Johnson 
USB Fly Light 

Kaz Adachi 
Norton Internet Security & Book 

Gerry Resch 
JVC Earphones 

 
Martin LaRocque 

15”LCD TV Monitor 

 
Mike Miller 

Android Tablet 

 
Dr. Don Armstrong 

2 Books 

 

Dennis Martin 
Disk Box 

 

Bill Van Horn 
LED Flashlight 

 
 

Your photo could 
be here - but only 
if you buy a raffle 

ticket. 
$1 per ticket or 6 

tickets for $5! 
Remember, 

parking permits 
are good for 2 free 

tickets! 
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SIG Meeting Reports 
Beginner’s Digital Photography  

By John Krill, SIG Leader 

Buying a Digital Camera? How Do I 
Find Just What I Need? 

One of the members e-mailed me 
asking that I recommend a camera to 
him. He gave me a list of requirements 
for a camera and asked me to name a 
camera model. 

First here is the e-mail: I need your 
recommendation of a Nikon Camera 

that will fit in my USCG uniform pocket using an eye view 
instead of a screen view that can record in RAW while I am 
bouncing around in the ocean providing assistance of a vessel 
in distress. Working with the Nikon D700 just isn't practicable 
while in action. 
 
His list of requirements: Nikon; small, lightweight; record RAW 
images; eye-level viewfinder. 
 
Note: The eye-level Viewfinder is what you find on SLRs and 
expensive rangefinder cameras. Recently a new technology has 
been developed. It's called Electronic Video Viewfinder or EVF. 
In the viewfinder is a small LCD screen that shows the exact 
same image that you see on the cameras large LCD screen. 
Cameras using an EVF generally are referred to as Mirrorless 
Digital Cameras. Certain models of Sony NEX and Nikon 1 V1 
digital cameras use an EVF. 
 
The Search Process 
 
The first step is to find as many cameras as possible that match 
his criteria. He made it a little easier because he limits his search 
to Nikon cameras only. If you wanted you could go to the 
NikonUSA web site and just browse their cameras but even that 
method may not get the results you want. 
 
For me the first stop is B and H Photo Video 
(http://www.bhphotovideo.com/) They have a very easy method 
for searching for product. At their home page click on the 
Digital Cameras and Gear icon. At this new page click View 
More under Digital Cameras.  
 
From this page, you can select all the criteria for your camera 
choice from the left sidebar. First, click the box next to Nikon 
under the Brand listings. If you have no idea what cameras have 
eye-level viewfinder or record RAW images you could review 
all the cameras listed under Nikon. Other search options are 
camera price and type of digital camera - DSLR, Point and 
Shoot, etc.  
 
B&H has a special search box (At the bottom of the left 
sidebar.) that lets you search JUST the items listed.  Lastly go 
through the list of cameras; find the ones that fit your criteria. 

Once you find the camera(s) you're interested in you can go to 
Digital Photography Review (www.dpreview.com) and see if 
they have reviewed or tested any of the cameras you found at 
B&H. Lastly find a store that has the best price or deal. We all 
know how to do that! 
 
PS: I did find a camera that just may fit his criteria: A Nikon 1 
V1 with the 10mm - 30mm kit lens. This camera is so nice I may 
start saving for one myself. 
 
Amazons' Daily Gold Box Deals 
 
I've mentioned this before but it's worth repeating. Amazon has 
daily Gold Box deals that can be the very item you've been 
wanting for months and now here it is at a very low price. They 
send out a daily email with the Gold Box deals. Sign-up. You 
never know. Just recently they had the Pansonic Lumix DMC-
LX5 Digital Camera for $269.00. That's a $100.00 discount. A 
very good deal indeed. 
 
Android Pad Users I Need a Volunteer 
 
I would like to demonstrate Adobe's new Photoshop Touch App 
(http://tv.adobe.com/watch/adobe-touch-apps/what-is-adobe-
photoshop-touch/) I will pay you to install the software App on 
your Android ($10.00). Any one interested? 
 
Standard Stuff That Is Always In This Report 
 
This report should be up on the SIG’s blog in detail & screen 
shots. If you have a special request for information regarding 
digital photography let me know. E-mail me using the address 
listed below. 
 
Check out the SIG Blog for other information and maybe info 
on what we will discuss at the next meeting. As always we will 
answer any and all questions. 
 
If you have a special request for information regarding digital 
photography let me know. E-mail me using the address listed 
below. 
 
We had 13 members at our SIG meeting. 
 
Note: I am using a new Web location for the photos I take at the 
meeting. I now upload the photos I take to Microsoft SkyDrive. 
A link will be put here every month to the folder with that 
month’s photos. SkyDrive Photos for the December 2011 Club 
Meeting: http://tinyurl.com/cwcb4av. 
 
PS: If you saw the actual link to the photos you would think it 
never ended. It's the longest link I've ever had to deal with. 
Solution is the TinyURL web site. Give it a really long link and 
they give you a nice short one. That's the link you see above. 
 
SIG Blog: http://nocccbgphotosig.wordpress.com/ 
 
Email: noccc.bgphotosig@gmail.com 
 
 
This SIG meets in Science 127 at 9:00 a.m. 

http://tinyurl.com/cwcb4av
http://nocccbgphotosig.wordpress.com/
mailto:noccc.bgphotosig@gmail.com
http://www.bhphotovideo.com/
http://www.dpreview.com
http://tv.adobe.com/watch/adobe-touch-apps/what-is-adobe-photoshop-touch/
http://tv.adobe.com/watch/adobe-touch-apps/what-is-adobe-photoshop-touch/


January   2012 19 

Advanced Digital Photography 
By Larry Klees, SIG Leader 

Last Month 
The topic was Layer Masks — the 
easy and powerful way to control 
pasted edges, transparent objects, 
and much more. 
 
We examined three different 
variations of mask. A stencil type to 
do the equivalent of a cut and paste; 
a continuous gradient which varies 
the transparency of a blurred layer 
to simulate shallower depth of field; 
and a large fuzzy elliptical mask on an adjustment layer to 
simulate vignetting in order to draw attention to the photo's 
subject of interest. 
 
Below are before (what we started with) and after (what we 
wanted) photos of a sculpture in a mall. 

In the after version the sculpture (main subject) has been 
sharpened and the contrast has been enhanced. The background 
has been blurred and the edges have been darkened. These three 
changes all cause the sculpture to stand out more from the rest 
of the image. 
 
Note that whenever Photoshop creates a layer 
mask, it automatically highlights the mask 
area so that the following tasks you perform 
will be applied to the mask and not to the 
image. Also, the foreground and background 
colors are temporarily replaced with white & 
black respectively. White, black and shades of 
gray are the colors you will use for the mask. 
 
Each of these changes used a different Layer 
Mask. 
 

The first step was to enhance the fountain. This was done by 
duplicating the original layer and then applying the 
enhancements to the entire layer. The wand tool was used to 
select the sculpture and the fountain. Rather than do a cut & 
paste operation or delete the background, it was easier to simply 
click on the "Add layer mask" icon at the bottom of the layers 
window. A mask like the one shown to the right was instantly 
added to the new layer. The white areas of the mask represent 
the area of the image that was selected and cause those portions 
of the layer to be opaque. The black areas cause the 
corresponding portions of the layer to be transparent. 
 
Here is a pair of greatly enlarged details of the area at the 
bottom of the moon's eye with the bottom layer hidden. 

 
The one on the left shows a checkerboard pattern in the 
transparent areas and the sculpture in the masked areas. If you 
zoom in very closely, you can see the jagged edges that I call 
the "cut out with kid's scissors" look. This is frequently the look 
you would get with a cut and paste operation. However, by 
applying a Gaussian Blur of a pixel or two to the layer mask we 
get a nice smooth feather to the edges, as shown on the right. 
The blur caused gray fuzzy edges to the mask, which in turn 
show up as partially transparent edges on the layer. This has the 
advantage that the edges can, later, be blurred more or 
sharpened without ever touching the actual pixels in the layer. 
Also, by altering the gamma on the mask, the selected areas can 
be enlarged or reduced; again without touching the original 
pixels. The brush tool can also paint light or dark areas on the 
mask to show or hide (respectively) additional portions of the 
layer. All of these operations can be changed repeatedly with 
zero degradation of the original image. 
 
Next, the background layer was again 
duplicated to create a center layer that will 
be blurred with a Gaussian Blur of about 
30 pixels. Two areas of more distant 
background will be selected and again the 
"Add layer mask" icon at the bottom of 
the layers window will be clicked to 
create a mask for that layer. The area 
around the palm tree was added to the 
mask with the brush tool set for black. 
Lastly the levels adjustment was used to 
turn the black areas to about 50% gray as shown. This will allow 
originally selected white (distant) areas with their 30 pixel blur 
to be opaque; but the former (mid distance) black areas, now 
gray, will show 50% of the blurred layer and 50% of the un-
blurred layer below which will look like a 15-pixel blur. The 
varying amounts of blur simulate a more shallow depth of field. 
You could even apply a gradient to the mask which would cause 
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the blur to gradually change from 0 – 30 pixels. You can't do 
that with a cut & paste. 
 
Finally, we go back to the top layer and 
use the "Elliptical Marquee" tool with a 
250 pixel feather to select the area around 
the sculpture. The selected area is then 
inverted and the "Curves tool is clicked in 
the "Adjustments Layer" window. This 
single click creates a new "Curves 
Adjustment Layer" with a "layer mask" as 
shown. Click on the finger tool in the 
Curves menu and click a drag in a 
downward direction on the image and the 
edges of the image will be darkened 
creating a vignette effect. The gradual transition from black to 
white on the mask makes the darkening gradual and un-
noticeable on the image; yet the viewer's attention is directed to 
the sculpture. 
 
At the January meeting  
In the early 1970s, Nikon placed a prototype un-manned camera 
with a timer on a train. The camera was aimed thru the window 
and when the train arrived at its destination, they developed a 
roll of film with in-focus pictures to usher in the era of 
commercial auto focus cameras. Since that time, auto focus has 
been improved with a bewildering array of enhancements, 
which also make it difficult to understand. There are multiple 
focus zones. There is automatic tracking. There is focus assist. 
There focus locking, etc. etc. etc. We will try to clear up much 
of this misunderstanding.  
 
This SIG meets in Science 131A  at 10:30 a.m. 
 
 

 Come, Care, and Share 
By Dr. Pat Adelekan, SIG Leader 

You are encouraged to come and 
share technology interests 
and related issues, problems, 
devices: i.e. Internet, social media, 
current trends, mobile computing, 
iPod’s, etc.  
 
This is a new multi-generational SIG to discuss and share
knowledge, techniques, ideas, concerns, feelings, dreams about
modern technology and its impact on society for both younger 
and older members.  
We encourage your ideas and input (on an on-going basis) to 
make this SIG the most stimulating and popular. The room is 
WIFI connected - So bring your laptops and other hi-tech gear.  
For questions or more information, please feel free to contact 
me:  Dr. Pat Adelekan, DTM -- 
Phone: 714-628-9844; Email: p_adelekan@yahoo.com 
 
This SIG meets in Science 109 at 9:00 a.m. 

 

Visual Basic for Applications 
(Access/Excel VBA) 

By Bob Dickson, SIG Leader 
  
The December session had to be cancelled due to a schedule 
conflict. I couldn’t get to the session until very late due to my 
required attendance at another meeting. I apologize to anyone 
who was inconvenienced by this schedule problem. We’ll 
resume with VBA discussions and programming in January. I’ll 
continue working on using the Menu feature rather than having 
command buttons taking up considerable space on the user 
form. Another feature under investigation is hiding worksheets 
that contain control data so that the operator can’t accidentally 
alter that data. I’m excited about digging deeper into Excel 
VBA. However, it causes some down feelings as I realize how 
little I know and how much there is to learn. Forty years in 
Information Systems with 20 years in programming during my 
working years and I’m still learning something new every time I 
turn the page (so to speak). I love it! Come up to Science 306 at 
10:30 am – Noon and let’s share your experience or dig into 
trying to find a solution to some problem (opportunity?) you 
have. 
 
This SIG meets in Science 306 at 10:30 a.m. 
  

Microsoft Access 
By Bob Dickson, SIG Leader 
  
The December session started early 
and ran late as we had so much to 
review and discuss. Helen’s Dolls 
project was the first topic of 
discussion. Not Access related itself, I 
spent considerable time since the 
November meeting editing the 130+ 
pictures of the dolls collection. I 
cropped each picture so only the doll 
itself could be seen, which also enlarged the picture of the doll 
when it was displayed on the user form. A considerable time 
was invested in creating a more doll-oriented user form with a 
general background color that enhanced the viewing of the 
dolls. A banner of lines and colors was added to further enhance 
the attractiveness of the user form, as well as more artistic type 
fonts. That’s a wonderful feature in Access that permits 
personalizing and customizing the user forms and reports to 
present just the image the developer desires. The new 
development was copied to a flash drive and uploaded to 
Helen’s laptop. During the month she’ll work on keying in the 
rest of the data for the dolls (only 45 records had been created 
for 116 dolls so she has some typing to do over the Christmas-
New Year’s holidays). I will be working on queries that will 
enable the operator to select specific dolls or category of dolls 
rather than displaying each and every doll.  
 
Don was attending the Access session for the first time. He’s 
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primarily an Excel person but wondered about this ‘database 
thing’ he’s read about. I hope the discussion expanded his 
interest in the subject so that he’ll return in January. He had a lot 
of good questions. I like those as that’s what makes the session 
livelier. Before January, I have to find out in Access how to set 
the justification for the columns in the spreadsheet format of a 
table. Of course it can be done; it’s so easy in Excel and Word 
but I don't work with the spreadsheet format (the dataview in 
Access) and the control is not shown on the menu. Once again, 
it’s that kind of thing that shakes the dust off the grey matter. 
And Bob (not me) had a work-in-progress on his flash drive he 
wanted to review. At the November session he described a 
volunteer organization he’s a member of and the copious 
paperwork they have in keeping track of their equipment. It’s all 
kept on paper and he wondered if it should be transferred to an 
Access database or to an Excel spreadsheet. At the November 
session we suggested he start by first entering the data in a 
spreadsheet and we could discuss it. He did that and had the 
spreadsheet. I displayed it on my laptop. We discussed his needs 
at some length. We ended with the suggestion that instead of an 
Access database, he should first use the spreadsheet and have a 
separate worksheet for each category of equipment and another 
worksheet containing the data on the individual members. 
Include an ID number for each person then put that ID number 
on each of the equipment rows to which that piece of equipment 
is assigned to that person. We also discussed and demonstrated 
hiding/unhiding columns and freezing columns and rows. He’s 
got some work to do but he was very pleased with the 
suggestions he received. It was a really good session. Nothing 
earthshaking, just “Friends helping friends.” That’s the 
NOCCC. Come up to Science 306 at noon – 1:30 and share your 
experience / problems / questions with us.  
 
This SIG meets in Science 306 at Noon. 
 

 PC Q&A 
By Jim Sanders, SIG Leader  

This month, the Build Your Own 
Computer (BYOC) SIG underwent 
a little bit of a revival. Some good 
questions were asked and I will 
review them. The first one was: 
“For equal nominal specifications, 
how do AMD and Intel CPUs 
compare in price, performance, 
compatibility, and reliability?” For 
equal nominal specifications, almost without fail the AMD 
brand of CPU is cheaper. In the performance category, both 
companies have tried to be King of the Hill, and a couple of 
times at least AMD has succeeded, but most of the time Intel 
has retained the crown of highest performance available. That 
performance often comes with a substantial price tag. The 
current holder of the crown, for highest performance, is the Intel 
Core i7 3960X (Sandy Bridge E), a six core behemoth that has 
15 MB of L3 cache, contains over 2 billion transistors, and 
requires a new CPU socket that has 2100 contacts. This CPU 
can be had for a mere $1200. There is a very interesting chart 
located at: http://www.cpubenchmark.net/high_end_cpus.html. 

The Core i7 3960X sets at the very top of that list with the 
benchmark score of 15,000. The AMD X4 640, which is the 
heart of the little black Shuttle computer that I take to the SIG 
meetings, sits halfway down the list with a score of 3697. That 
is not quite 25% of the top score, yet it seems to be a fairly 
peppy little computer. 
 
If you click on that Core i7 3960X at the top of the chart, it 
takes you to another page that shows you bang for the buck 
numbers. The Core i7 3960X is quite a ways down on that list. 
The AMD Phenom II X6 1100T, rated at 42% performance of 
the 3960X, only costs 17% of the price of the 3960X. On that 
same chart you will see that the Intel 2500K is given the best 
bang for the buck rating of all the CPUs on the list. It should 
also be noted that while almost all of the CPUs in the top half of 
the list are made by Intel, a large number of them are the 
commercial Xeon CPUs. It is also interesting to note that while 
the 2500K is at the top of the bang for the buck list, and costs 
$215, the AMD Phenom II X6 1100T is number three on the list 
and costs $200. So at that level, there is very little difference 
between the two chips in terms of performance for money spent.
 
As to compatibility, that's mostly a function of the instruction 
set of the CPU. At the hardware level there is no compatibility. 
Each requires a different kind of socket and uses significantly 
different interfaces. At different times, AMD has had a more 
extended instruction set that Intel, and vice versa. Over time, 
each has implemented the instruction extensions of the other. At 
a practical level, if there are any differences in the instruction 
set, an exception interrupt occurs and the missing instruction is 
emulated by a software subroutine. 
 
As to reliability, in all of the years that I have dealt with x86 
computer systems, I have seen several CPU failures that were 
due to abuse. The most common occurrence of the abuse is the 
miss installation of the heat sink and the subsequent overheating 
of the CPU to destruction. During that time I have only seen one 
instance of a CPU dying due to some natural cause, and that had 
to happen to one of my own computers. 
 
The second question had to do with unlocking cores. The first 
instance that I know of concerning this procedure had to do with 
the AMD X3 CPUs, which were originally X4 for CPUs that 
have one bad core. There were reports that in order to fill the X3 
orders when they ran out of enough bad X4 parts, they would 
take the good X4 parts and disable one of the cores. Supposedly,
there was a procedure that allowed that disabling to be undone 
in some cases. Is the crapshoot of buying an X3 CPU, with the 
hope that it might be one of the ones that it is possible to undo 
the core disabling and converting it into a X4 CPU, worth it? I 
don't think so. In general, I would say this is a bad bet, and the 
possible dollars savings is hardly worth it. 
 
A third question was: “For newer machines without RS-232 
serial ports, external adapters are available that provide such a 
port, but plugged into a USB port on the machine. For machines 
without a Centronics parallel port, are similar adapters available 
to provide a parallel port capability?” In a word, yes. I have seen 
several of those USB parallel port adapters. Another approach to 
that problem is to purchase a parallel port add-in card that plugs 
into the PCI bus. This is probably a better approach than using 
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the USB adapter. Just as an FYI, I have seen a number of new 
motherboards that in fact have an RS-232 port built in the 
motherboard. In order to use it, you have to purchase an adapter 
cable that mounts the DB-9 connector on a filler panel that takes 
up one of the expansion slots of the machine. 
 
A fourth question was: “Do you consider overclocking to be a 
good idea in normal use?” And my answer is no, I do not. 
Unless you have the time, knowledge, and patience, to run a 
thorough parametric test on the computer system at different 
overclocked rates, you run a real risk of having an unstable 
machine. Now if you are just playing games on the machine, 
and the game crashes, no big deal. But if you are running 
Quicken and the computer hiccup's and gets an error on some 
check that you enter, or some report that you generate, you 
might not care for the results. I'm not sure how much longer I 
will be running the BYOC SIG as there does not seem to be a 
great deal of interest in it. So be sure to bring your questions and 
discussion points to the January meeting as that just might be 
the last one of these that I will do. 
.Hope to see you then! 
 
Jim’s two SIGs meet in the Irvine Hall at 10:30 a.m. and 12:30
p.m., respectively.  The first is the Beginner’s PC Q & A and the
second is for everything and everyone else. 
 

Understanding Operating Systems  
Charlie Moore, SIG Leader 

this SIG is lead by Charlie Moore 
and is a continuing discussion group 

about Operating Systems for computers. 
 
This SIG meets in Science 111 at 
10:30 a.m. 
 
 

Linux Desktop & Administrator  
By Bob Ray, SIG Leader 

We started off our group 
meeting with some small talk 
about Linux in general.  We 
discussed the upcoming B-
tree file system, named 
“Btrfs.” This new file system 
will most likely replace most 
or all of the older and prior 
Linux file systems in the 
future.  The advantages of this file system are many.  We briefly 
touched on just a few of these advantages.  Members who were 
interested in the details of such were pointed to Google for 
further in-depth information.  I might add here that the B-tree 
file and search method has been around for decades.  However, 
the new “btrfs” has incorporated many new advanced file 
features.  This may be the “final frontier” for computer file 
systems? 

We discussed some of the advantages and also the many 
possible disadvantages of what is being promoted as Layered 
Software.  There are three layers offered by proprietary software 
merchants and developers.  The first layer is free to the end-
user. This is the “cheese” in the “mouse trap,”  The idea here is 
that you as a user of this software or application would go for 
the bait and give it try and hopefully use it and like it. Like 
getting your paw stuck in the trap - no big hurt.  Once you, the 
user, have become accustomed to the application and like it but 
would like the more advanced “goodies” the application has to 
offer you, then you would most likely be tempted to take the 
next step. Phase Two! The second phase is not free but rather 
“reasonably priced.”   The user then goes into this second layer 
of the application.  This is the turning point in the market plan 
of the software vendor.  You invest time, months or even a year 
or so, you become very comfortable using this application.  This 
phase is like the “Rat Trap” Ouch! The pain hurts but the 
desired end-result seems to be worth the pain.    
 
Now comes phase three.  This is the “Bear Trap” the most 
advanced phase of the proprietary software merchants offering.  
Once you are at this stage, the price has gone up to the max, you 
have invested a great deal of time and money and you most 
likely would be very reluctant to switch to a different but similar 
software application or even a better software package.  Perhaps 
you and or your organization have made a major commitment at 
this point hoping that this investment will payoff in the future 
and in productivity savings, etc.  Plus, you most likely have a 
great deal of your own software resources built into or around 
this  Package Software.  The Merchant Vendors of such 
software refer to this phase as the “Got Ch'a” phase, which is 
exactly where they want their customer base to be.  My end note 
to potential users is BEWARE of layered proprietary software.  
Nuf' said. 
 
 
These SIGs meet in Science 131 at 9:00 a.m .and 10:30 a.m. 
 

Mobile Computing SIG 
 

By Ben Lochtenbergh, SIG Leader 
 
This SIG now has an Access database 
program that lists all mobile devices used by 
the members so far. The idea is to collect 
what pertinent information there is, and be 
able to focus on one device at a time. Also, 
members having the same device or thinking 
about buying one, will be able to more 
readily exchange details. So, this database 
will take a subset from the overwhelming 
multitude of device information out there in 
the world and dwindle that down to what we 
actually need to know to support each other in this SIG. The 
number of devices in the database currently is 11. 
 
We passed a paper form to pencil in updates during the meeting, 
and did a few live updates during the housekeeping part of the 
meeting. In the future this database can be emailed part or whole 

T 



to those who ask for it. Consider the code open source to our 
SIG. 
We have an email list where attendees and interested NOCCC 
members receive the monthly PowerPoint presentation of what 
the next meeting’s agenda is. The number of email contacts in 
this list is 19, and usually is send a day or two before the Sunday 
of the meeting. The idea here is to be as current as possible. 
Some members are going to have new devices gotten for 
Christmas, and the new Consumer Electronics Show will be in 
the media at that time, as topics to cover. 
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Connecting to the University Wi-Fi system with NOCCC 
member devices, smartphones, tablets, and laptops remains a 
priority. As long as your device has Wi-Fi, we’ll have it as a 
regular member service to connect your device to the Internet. 
No one should be without it. Be connected. I think we have a 
100% success rate with this 

 
This SIG meets in Science 109 at 10:30 am. 
 

Visual Programming 
Anson Chapman, SIG Leader 

his SIG is lead by Anson 
Chapman and is a continuing 

discussion group about computer 
programming using Visual Basic, 
Visual Basic Script, Visual C, Visual 
C++ and Visual J++ for Beginners. 
 
This SIG meets in Science 111 at 
9:00 a.m. 
 

Microsoft Office 
Tia Christian, SIG Leader 

hese sessions are open forums 
for problems incurred using 

Microsoft Word, Excel, Outlook  
versions 2003 to 2007,  and 
Open Office and their 
resolutions.  During these SIG 
sessions, different topics will be 
discussed during each session on 
these four software applications 

and their functionalities. Tia welcomes your attendance.  The 
more in attendance! The better the SIG session! 
This SIG meets in Science 306 at 9:00 a.m. 
 

From the Desk of the Membership Chairman 

By Ben Lochtenbergh, bal@msn.com 

Two SIG leaders have agreed to allow links to short videos 
about their proceedings to be available to the members. The 
links point to YouTube to be specific. These are not Public 
videos; only by knowing the following links can NOCCC 
members, their families, and potential NOCCC members view 
them. They are specified as Unlisted videos. Try and Google 
them without the links ☺ you should NOT be able to find them. 
Beginners Digital Photography 60 second video: 
http://www.youtube.com/watch?v=bSqpC4O0Dgk 
Come, Care, and Share 190 second video:  
http://www.youtube.com/watch?v=Y0tN6kWAs6w 
 
If this works for our club they will remain, even possibly made 
Public. More and better videos can then follow, but if anyone 
complains, it’s easy to change the online status to Private or to 
totally delete one or all videos. Because of this links may be 
deactivated after this column has been submitted to the Orange 
Bytes editor. 
 
One of our members, Muriel Fitzsimmons, prepared a one-page 
flyer to promote our club to those who might want to know 
about NOCCC. The intent is to have a stack of them on the table 
near where Ted displays his books-and-software for review. See 
photograph below. More flyers will be placed at local libraries 
and such. The board reviewed the flyer and liked it. Hopefully, 
we’ll sign up a few new members as a result.  
 
We thank all those who volunteered to make this club function 
last year and those who attended the meetings. We hope y’all 
had wonderful holidays and are ready for a Happy New Year! 
 T 
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Club Business 

Transportation Information 

Meeting Information 
The NOCCC meetings are held at Chapman University, in the 
Hashinger Science Center and Irvine Hall, near the northwest 
corner of Center Street and Palm Avenue. 

Parking Information 
Most of this information is on the back cover.  For more 
information, see www.chapman.edu/map/parking.asp.  A map 
of the Chapman University campus is also available at 
www.chapman.edu/map/map.pdf.  

Bus 
Several Orange County Transportation Authority (OCTA) buses 
service Chapman University.  Route 54 runs East and West on 
Chapman Ave.  The 59 runs North and South on Glassell 
Avenue, but doesn’t start early enough for the 9:00 a.m. SIGs.  
Get the most current information or use a trip planner at 
www.octa.net.  OCTA also has a Consumer Information Center 
at (714) 636-7433 (RIDE). 

Railroad 
Metrolink trains can get you to the NOCCC meeting from the 
Inland Empire.  There are stops in the cities of Riverside, 
Corona, and Anaheim Hills.  Parking your vehicle is free at the 
train station. (See M on map below.) 
On Sundays, Inland Empire-Orange County Line train 857 
leaves San Bernardino destined for Orange County at 7:30 am. 
Train 859 leaves at 8:55 am.  For the return trip, train 858 leaves 
nearby Orange Metrolink at 3:55 pm and train 860 leaves at 
5:35 pm.  The Metrolink station is four-and-a-half blocks from 
Chapman University.  For specifics regarding your trip, check 
the web site: http://www.metrolinktrains.com or call 1-800-
371-5465. 

Board Meeting Minutes 
December 5, 2011 

he NOCCC Board held its regular monthly meeting at 
President Jim Sanders’ residence on Monday, December 
5, 2011.   

 

All Board members attended in spite of the blustery weather. 
The Vice President’s position is still open.  Jim Sanders again 
reminded us that he will not serve as President beyond his 
current term and it is imperative that someone volunteer for the 
open VP job. It has been a long-standing practice for the VP to  
serve as the next President. 

Secretary’s Report: given by Ted Littman. The minutes of the 
November 7th Board meeting published in the December 2011 
Orange Bytes was motioned for approval, seconded, and 
approved by all in attendance. 

Treasurer’s Report: given by John Heenan. Net income for 
coffee and donuts/cookies was $13.  The Raffle earned $83; cost 
to NOCCC of the prizes was not available. 13 parking stubs 
were turned in for free raffle tickets. The total unit cost for 
production/shipping/distribution of the November print 
newsletter was $1.63. For the fiscal year to date, it was $1.83. 
 
Memberships: As of December 1:  Regular (1-yr.) = 151, 
Regular (3-yr.) = 11, Family = 6, College Student = 0, 
Newsletter = 12; Total of 180 Members. This represents a 
decrease of one. The Board accepted the Treasurer’s report. 

Opening & Closing: Richard Miller prepared the coffee. Bob 
Love got the donuts and cookies. There were no significant 
problems.  

Main Meeting: SIG Leader Larry Klees’ presentation on Flickr 
was attended by about 32 people. (See the Main Meeting report 
elsewhere for details.) 

Programs: The next Main Meeting is Sunday, January 8th, 
followed by the BOD meeting on Monday, January 9th at the 
President’s residence. A speaker has yet to be obtained for 
January. Jim sent an email to Gibson Research inviting him to 
speak. Richard is awaiting responses from the local Microsoft 
store and Google. Dr. Pat will also contact several acquaintances 
about giving us a presentation. A considerable amount of time 
was devoted to discussing possible topics. 

Public Relations: Dr. Pat made a number of suggestions 
regarding things to do to publicize the club and increase interest 
in attending meetings. She emphasized the need for personal 
interaction with people in soliciting new members and at SIG 
meetings. 

Publications & Reviews: given by Ted Littman. A number of 
books on social networking and computing for seniors were 
obtained from several publishers at the request of Dr. Pat.  No 
books were taken for review at the meeting on Sunday.  The 
December newsletter had two book reviews by NOCCC 
members. Although the print newsletter was mailed at the post 
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office before Thanksgiving, several members complained that 
they did not receive their copies before the meeting. There could 
be a problem with the Jan. newsletter too due to the Christmas 
& New Year holidays. Two book reviews were received for the 
January newsletter and two are due in December. Ted also urged 
all newsletter contributors to email their inputs for January to 
him early. Several were received today! Tony Loechner notified 
us that he will be unable to continue as Production Editor due to 
personal issues. His help in assembling the Bytes with Adobe In 
Design was much appreciated. Ted will do the assembly using 
Microsoft Word. 
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Membership: given by Ben Lochtenbergh. Ben showed us a 
draft flyer prepared by Muriel Fitzsimmons for use in 
publicizing the activities of NOCCC by posting on the bulletin 
boards of local organizations, schools, etc. Several Board 
members make suggestions. Ben also contacted the high school 
junior who attended several months ago. Unfortunately, he will 
not be able to participate at our monthly meetings due to the 
demands of schooling. 

Raffles: given by Gerry Resch.  Ticket sales brought in $83 Ted  
donated one software program for the raffle and will contribute 
several books for the Jan. raffles. Jim will purchase the “big” 
prizes. 

SIGs: by Dallas Hazleton. Dallas reported on attendance at the 
various SIG meetings. The best attendance was at the Advanced 
PC Q&A SIG (31), Mobile Computing (13), Come, Care, Share 
(11), Beginners Digital Photography (13), Mobile Computing 
(13), Advanced Digital Photography (7), & Beginners PC Q&A 
(7). The least attended SIGs were Visual Programming (2), 
Access/Excel VBA (4), and Microsoft Office (2).  

Old & New Business: Nothing to report. 

The Board meeting was adjourned at 9:10 PM. 

(continued from page 15) 
One of the quotes about Photoshop is that “If you don't know 
layers, you don't know Photoshop.” When I first started using a 
program that offered layers, and learned some of the basic ways 
in which they could be used, I was quite pleased with the results 
that I was able to obtain. There are so many different things that 
layers can do, but just a bare description of the function is 
insufficient to understand them. That is particularly so when you 
start stacking layers. Many of the functions covered in this book 
involved using layers. I liked the way in which the author 
explained the importance of creating adjustment layers as 
opposed to adjusting the basic image itself. After reading that 
section, I'm going to try and use that technique on most of my 
adjustments in the future. 
 
Two more highlights of too many more to mention, the 
importance and techniques of Sharpening, and HDR (High 
Dynamic Range) image creation. This book is crammed full of 
items that a serious user of Photoshop should know about. In 
many instances, features that are written about in this book are 
covered in enough detail that you can use the explanation 
provided as is, however, many assume a level of expertise that 
may be lacking. In several instances going to Photoshop help 
was enough to clear up my confusion. In many others, Googling 
“How to” on that subject (Love Google!) provided a cornucopia 
of information at multiple levels of understanding. I think it is 

fair to say that this is more of a great reference book than a 
detailed how-to book. In that context, a great addition to your 
knowge library. 
 
Real World Adobe Photoshop CS5 for Photographers: Industrial-
Strength Imaging Techniques 
Author: Conrad Chavez 
Published by: Peachpit Press September 25, 2010 
ISBN-13: 978-0-321-71983-6 (paperback) 
Paperback: 586 pages, List $59.99, Amazon $41.99 
http://www.peachpit.com/store/product.aspx?isbn=0321719832 

NOCCC Bylaws  
he club’s Bylaws are available at our website: 

www.noccc.org/bylaws/ 

Thanks to Our Members Who 
Renewed in November 2011 

 

� Kaz Adachi 
� Donald Armstrong 
� Jim Atkinson 
� Larry Bufton 
� Robert Goclowski 
� David Hobart 
� Martin La Rocque 
� Rudy Lauerbach 
� Larry Sears 
� Armand St. Marseille 
� Gordon Strickland 
� Richard Weiland 

NOCCC Fee Schedule 

he fee schedule has been set up to increase club 
membership, attract people with an interest in computing, 
and attract local computer-related businesses to place ads 

in the Orange Bytes with or without becoming NOCCC 
members.  We are also offering members the opportunity to 
help our club financially by making donations that should 
be income-tax deductible since we are chartered as a non-
profit 501(c)(3) organization.  Donors will be acknowledged in 
the Orange Bytes and the Membership level will be shown on 
the Member’s Badge. Your regular dues is tax deductible! 
 
Membership Level ($) 1 Year 3 Years 
Individual Member ....................................................35 ......... 90 
Each Additional Family Member..............................15 ......... 45 
Full-Time* Enrolled College Student .......................20 
Enrolled High School Student ...................................15 
*Minimum 12 Semester Hours 
Business Member + Ad (Business Card) ................180 
Business Member + Ad (¼ Page, ½ Page)...............465 , 800 
Business Member + Ad (Full Page)......................1,475 
 
Membership Donations ($) 
Contributing Member................................................75 
Supporting Member.................................................100 
Advocate Member ....................................................250 
Patron Member ........................................................500 

T
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Your business card 
would look good here too!! 

 
For information about advertising in the 

Orange Bytes, contact editor@noccc.org.  
 

Classified ads by NOCCC members cost $5 
for 1-25 words and $10 for 26-50 words. 

Pig SIG Open to All FREE AD SPACE 
 

If you are an NOCCC member, and have a computer-related, 
non-commercial or “Talent Available” ad that you would like 
to have placed in this newsletter or on the NOCCC web site, 
send an e-mail with a copy of your business card or ad to the 
NOCCC Editor at editor@noccc.org. 

Meet us outside Irvine Hall from 
about noon to 12:30 p.m.  There 
are several benches where NOCCC 
people gather, eat and chat.  Just 
look for the member badges, grab a 
chair and join in!  This is an 
informal group; so many different 
subjects are discussed.  It’s a great 
opportunity to mix, mingle, and 

network! 

 
 
 

 
Free coffee & tea at the January meeting! 

 
Donuts $1/Each & Cookies $.50/Each 

No Freebies! 
Put your dollars & quarters in the 

collection can. 
(continued from page 15) 

One of the quotes about Photoshop is that “If you don't know 
layers, you don't know Photoshop.” When I first started using a 
program that offered layers, and learned some of the basic ways 
in which they could be used, I was quite pleased with the results 
that I was able to obtain. There are so many different things that 
layers can do, but just a bare description of the function is 
insufficient to understand them. That is particularly so when you 
start stacking layers. Many of the functions covered in this book 
involved using layers. I liked the way in which the author 
explained the importance of creating adjustment layers as 
opposed to adjusting the basic image itself. After reading that 
section, I'm going to try and use that technique on most of my 
adjustments in the future. 

 
 

 
Two more highlights of too many more to mention, the 
importance and techniques of Sharpening, and HDR (High 
Dynamic Range) image creation. This book is crammed full of 
items that a serious user of Photoshop should know about. In 
many instances, features that are written about in this book are 
covered in enough detail that you can use the explanation 
provided as is, however, many assume a level of expertise that 
may be lacking. In several instances going to Photoshop help 
was enough to clear up my confusion. In many others, Googling 
“How to” on that subject (Love Google!) provided a cornucopia 
of information at multiple levels of understanding. I think it is 
fair to say that this is more of a great reference book than a 
detailed how-to book. In that context, a great addition to your 
knowledge library. 

 
 
 
 
 
 
 
 
 
 
  
 Real World Adobe Photoshop CS5 for Photographers: 

Industrial-Strength Imaging Techniques 
Author: Conrad Chavez 
Publication Date: September 25, 2010 
Published by: Peachpit Press 
ISBN-13: 978-0-321-71983-6 (paperback) 
Paperback: 586 pages, List $59.99, Amazon $41.99 

 
 
 
 

mailto:editor@noccc.org
mailto:editor@noccc.org
mailto:jsanders@ligasmicro.com


January   2012 27 

Publication Information 
Orange Bytes is published monthly by: 
North Orange County Computer Club  

P.O. Box 3616, Orange, CA 92857 
 

All opinions expressed herein are those of the individual 
authors only and do not necessarily represent the opinions of 
the NOCCC, its officers, Board of Directors, the Orange Bytes 
newsletter or its editors.  The NOCCC does not guarantee the 
accuracy or the correctness of advertising or articles in the 
Orange Bytes, nor does the NOCCC intend to endorse, rate, or 
otherwise officially comment on products available.  
Therefore, the readers are cautioned to rely on opinions 
presented exclusively at their own risk. 

 

 
Commercial display advertisements  

are welcome, contact  
editor@noccc.org.  

 
RATES 

 One Page Vertical .......... 7.0” x 9.5” ...............$150  
 Half-page Horizontal ..... 7.0” x 5.0” .................$80  
 Half-page Vertical  ......... 3.5” x 9.5” .................$80 
 Quarter-page ................... 3.5” x 5.0” .................$45 
 Business Card ................. 3.5” x 2.0” ................$ 15 
 Center Spread................ 14.0” x 9.5” ...............$300 

Deadline: Tenth of the month  
 

Discounts: 3months=10%, 6=15%, 12=20% 
If you are interested in advertising in the publications of 

multiple User Groups throughout the region or nationally, 
you can learn more by contacting http://www.apcug.org 

 
Readers, please tell our advertisers that you saw their ad in the 

Orange Bytes 

Trademarks/Copyrights — The mention of names of products 
in this publication without trademark or copyright symbols does 
not imply that they are not so protected by law.  All trademarks 
are the property of their respective owners. 
Production — Orange Bytes was produced with Microsoft 
Word ® using the True Type fonts Arial, Bauhaus 93 and Times 
New Roman. 
Printed by: Creative Technology 
                         5959 Palmer Blvd. 
                         Sarasota, FL 34232—28  
                         800-533-1031 
 

QUICK MEMBERSHIP APPLICATION/RENEWAL 
Date: ________________  I am a new member � 
 This is a renewal; my membership number is  _______ 

PLEASE PRINT! 
Name ______________________________________________________ 
Address____________________________________________________ 
City _______________________________________________________ 
State_______ Zip _______________ Phone (______) ______-________ 
email______________________________________________________ 
Fees: see page 25 for fee schedule; $35 for single membership. 
Since the North Orange County Computer Club is incorporated as a 501 (c) (3) 
organization, checks are 100% tax deductible when made payable to North 
Orange County Computer Club. 

Amount enclosed $___________________ 
MC / Visa No. ________________________ Expires ________ 
Please make your check payable to North Orange County Computer 
Club and mail with your application to: 

North Orange County Computer Club 
PO Box 3616 
Orange, CA 92857 

Membership Renewal 

When you turn in your 
Membership Renewal check, 

PLEASE fill out a Membership 
Renewal Application. 

 

Memberships may also be 
renewed on our Website: 

https://mmm1427.rapidsite.net/
citivu/noccc/order3.html 

Send e-mail address changes 
to membership@noccc.org 

https://mmm1427.rapidsite.net/citivu/noccc/order3.html
https://mmm1427.rapidsite.net/citivu/noccc/order3.html
mailto:membership@noccc.org
http://www.apcug.org/
mailto:editor@noccc.org
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Members: Your expiration month  
and year appear on your mailing  
label. Please renew promptly,  
using the application inside. 
 

Dated Material - Please deliver by January 7, 2012 

Dogs of C Kennel by Mick and

Are You an NOCCC Member? 
Consider all that you get with membership and Join Now! 
� Meetings. Keep up with what’s going on in the computer 

world.  Hear outstanding industry representatives make 
presentations of the latest and greatest in computer products. 

� Special Interest Groups. Our SIGs cover a broad spectrum of 
computer issues.  Whether you are a beginner or a power user, 
attend the lectures and demonstrations, and share your 
knowledge about computers. 

� Raffle Drawings. We have distributed thousands of dollars 
worth of hardware, software, and books as prizes at our Main 
Meeting.  

� Consignment Table. We have a consignment table during 
even-month meetings, in which members can sell or buy all 
kinds of computer & software items. 

� Get help with your current computer problems.  In the 
Random Access portion of the Main Meeting, you may ask 
your question of the entire assemblage.  More than likely, 
someone will have the answer. 

� NOCCC Help Line. NOCCC volunteers, experts in their 
fields, are ready to assist you with your computer problems.  
They can be contacted by email or by telephone. 

� The Orange Bytes Newsletter. Our award-winning newsletter 
reports on club activities and provides articles about current 
computer issues and reviews of software and books. 

� Product Reviews. Write a review for the Orange Bytes and 
keep the software, hardware, book, or CD! 

� Volunteer Work. We have numerous interesting assignments 
available.  As an all-volunteer organization, you can join with 
other members in a variety of activities: solicit newsletter ads, 
write articles for our newsletter, conduct a seminar, run a SIG, 
give a Main Meeting presentation, show new members 
around, join a committee, assist in setting up the meeting or 
participate in computer-related community volunteer work. 

Become an NOCCC member by signing up at the 
Reviews/Membership Desk during a general meeting, usually 
the first Sunday of the month.  Or simply fill out the form on the 
reverse side of this page and send it in. 
Meeting Information — The NOCCC meeting is held at 
Chapman University, in the Hashinger Science Center and 
Irvine Hall, near the northwest corner of N. Center St. and E. 
Palm Ave.  
Parking Information - Chapman University’s main parking lot 
is the underground Lastinger Parking Structure under Wilson 
field on the north side of the campus.  Enter from Walnut 
Avenue, just east of Glassell Street.  Parking is not free on 
Sunday, even if the gate is up.  However, the permit vending 
machine is about 100 feet south of the entry area. There are 
other machines elsewhere in the lot.  Find one, buy a permit, 
and put it on your dashboard.  Do not park in any other lot, in a 
reserved space, or back into a space. 
Free street parking also is available on the campus-side of the 
streets only. Parking in front of any residential housing will 
result in an expensive parking ticket. A City of Orange public 
parking lot, located on the southwest corner of E. Maple and 
N. Orange, is also free and only 2 blocks from the meeting. For 
more information, see the Transportation Information section. 
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